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Getting Started

Important Notes!

Harware Exchange

If you use local HiCAD/HELiOS licenses and want to exchange any hardware components, modify the par-
titioning of, or re-install the operating system, you need to revoke the existing license on the HiCAD/HELiOS
workstation first, and request, using the new hardware or modified configuration, a new license key (further
information on the procedure can be found in the software documentation).

If a revocation is technically possible, but will not be performed, the ISD reserves the right to charge costs in an
appropriate amount for the reissuing of the license. If the license will not be revoked, or if such revocation is no
longer technically possible, the ISD may request proof that the unrevoked license is no longer utilisable; in
case of failure to produce such proof, the ISD reserves the right to refuse the transfer of the license to a new
hardware.

Discontinuation of Windows® 7

Microsoft will cease the support for Windows by January 2020. For compatibility reasons HiCAD 2020 SP1 and
HELiOS 2020 SP2 will thus be the last versions of our CAD and PDM systems which support Windows ® 7. The
corresponding server operating systems (Windows Server 2008 R2 or older) will then no longer be supported
either.

Discontinuation of HELiOS 32-Bit

As of HELiOS 2022 (Version number 2700.0) there will no longer be a 32-Bit version available for HELiOS.
However, the interface to 32-Bit applications such as Office will still be possible and is not affected by the dis-
continuation of the 32-Bit installation of HELiOS.

Discontinuation of Oracle

With HELiOS 2022 (version 2700) onwards, Oracle is no longer supported as a database platform.

Discontinuation of Mircosoft Office 2010 interface

From HELiOS 2021 (Version number 2600.0) on, we will no longer support Office 2010 in the HELiOS – Office
interface.

Discontinuation of "old" OpenGL versions

From HiCAD 2021 on, only OpenGL version 4.3 is used in all HiCAD modules. Until now this was only the case
with the module HiCAD Point Cloud. This means that HiCAD 2021 can no longer be run on computers without
a separate graphics card. Further information can be found in the HiCAD 2020 News.
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Discontinuation of "old" HiCAD itemization

As of HiCAD 2019 the “old” itemisation, i.e. the itemisation that was used up to HiCAD 2017, will only be avail-
able for model drawings that were already itemized with these functions. From HiCAD 2021 onwards, only the
“new” itemization will be supported.

Data compatibility

HiCAD 2020 uses a different data format, which means that.SZA files saved with HiCAD 2020 can no longer be
loaded into older HiCAD versions.

When performing a HELiOS update, the update start mask shows you the HELiOS subversion, which needs to
match the existing database. If this is not the case, only an error message will appear when you start HELiOS.
To update the database schema, use the program HeliosDbUpdate.exe. If the database schema requires an
update, you can no longer access the database with older HELiOS versions. Therefore, all workstations
accessing the database need to be readjusted accordingly at the same time.

New Mask Editor in HELiOS 2020

Due to the complete revision of the Mask Editor in HELiOS 2020, the previous mask format has been changed
from .MSK to .XML. In addition, mask files are now managed outside the installation directory, resulting in
some changes in the system architecture that Administrators must consider:

n The masks of older versions (before V 2500.0) that were previously stored in the SYS directory of the install-
ation are automatically converted to the new XML format in case of an update installation and stored at
%Programdata%.

n The new masks at %Programdata% should not be overwritten under any circumstances, as these rep-
resent the "delivery status", which will be updated by later update installations. If masks are edited and
changed with the Mask Editor, youmust store and call them at %Appdata%.

Updating the HELiOS-Inventor interface

For an update of the Inventor interface from an older HELiOS version to HELiOS 2020 (Version 2500) or higher
(and the corresponding update of the database schema) the following changes have to be considered:

1. The structure identifiers for Inventor parts must be updated.

2. The standard part and semi-finished product identifiers are changed to a document-based (instead of art-
icle-based) management.

An update installation can only be carried out after an appropriate preparation of the migration.

In case of an update, please contact the Consulting team of the ISD Group. New installations of HELiOS 2020
and the associated database are not affected.
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Updating the HELiOS-SOLIDWORKS interface

For an update of the SOLIDWORKS interface from an older HELiOS version to HELiOS 2020 (Version 2500) or
higher (and the corresponding update of the database schema) the following changes have to be considered:

Since a migration of the configuration IDs is performed during the update, an update installation can only be
performed after the migration has been prepared accordingly. In the event of an update, contact the Con-
sulting team of the ISD Group. New installations of HELiOS 2020 and the associated database are not
affected.

Important update notes for attribute mapping in title blocks

Until HELiOS 2019, attribute mapping at SOLIDWORKS was done by the following files:

n heliossw_titleblock.dat (attributes for the title block),

n helios_cs_global_config.dat (attribute mapping/presetting in both directions),

n sw_comp_name.dat (display in the model tree in CAD).

As of HELiOS 2020 (Version 2500.0), the mapping must be set up again manually. No migration tools exist.

Up to HELiOS 2019, the attribute for the title block in AutoCAD was created using the following files:

n heliossac_titleblock.dat,

n helacblock.xml

As of HELiOS 2020 (version 2500.0), the mapping must also be set upmanually here.

In case of an update, please contact the Consulting team of the ISD Group.

Important notes for administrators during a HELiOS update installation working with the HELiOS integ-
ration for Inventor, AutoCAD and SOLIDWORKS!

When updating the database to HELiOS 2019 Service Pack 2 or higher, the old workspace is checked for doc-
uments in progress. These are documents with the pen symbol in the respective (old) workspace dialog, or
entries of locked documents in the Workspace Manager from HELiOS Desktop (on the right hand side).

Should the check find relevant documents, the following message appears:

The update of the database cannot be performed because there are still locked documents in old local work
areas which will not be supported in the future. After this update, only work areas with new administration are
supported and automatic migration is not possible. More information can be found here.
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HELiOS Data base schema

As existing datasets with non-compliant conditions may cause conflicts during the central update process of
the HELiOS delivery database, you should consider the following:

1. Do a database backup: You shouldmake sure that a backup of your HELiOS database has been created
before the update. This can be done with the HELiOS Database Creator or via your SQL server application.
Please contact the ISD hotline if you have any questions or need support for your individual system archi-
tecture.

2. The log file of the update: If any conflicts occur during the update, they are traced in the log file
HeliosDbUpdate.txt (in the system path%appdata%\ISD Software and Systems\HeliosDbUpdate\). Have
this file ready if you contact the ISD hotline for troubleshooting and successful updates.

Operating system

We recommend deactivating local licenses and network licenses before performing an update/upgrade of the
operating system (e.g. from Windows 8 to Windows 10), and activating them again after successful update/up-
grade of the operating system.

New HiCAD module structure

The modules HiCAD ALUCOBOND® exclusiv Standard and HiCAD ALUCOBOND® exclusiv Premium will no
longer be available from HiCAD 2019 onwards. They have been replaced with the two odules HiCAD
ALUCOBOND® Suite Standard and HiCAD ALUCOBOND® Suite Premium (formerlyHiCAD ALUCOBOND®
hybrid Standard and HiCAD ALUCOBOND® hybrid Premium).

The Steel-/Metal Engineering module has been discontinued with the release of HiCAD 2018 (Version 2300). It
has been replaced with the two modules HiCAD Steel Engineering and HiCAD Metal Engineering.

New HELiOS Module structure

From HELiOS 2018 (Version 2300) onwards the module structure has been changed. Also, the interfaces
between HELiOS and the different CAD and electrical engineering systems are now licensed separately.

Discontinuation of the old figure format (FIG)

Since HiCAD 2017 we have been supporting FGA as figure format (before FIG). Starting with HELiOS 2021 (Ver-
sion 2600.0), we assume that the figures stored in HELiOS have been converted to the new format, or convert
the still existing figures automatically as part of the database sub-version update to Version 2600.0.

Please use only this new .FGA format for conversion of existing 2-D .FIG files! For this purpose, use the new
Converter_FIG_To_FGA.exe tool in the HiCAD\exe directory.

When updating from HiCAD 2016 or older, all standardly supplied 2-D parts (e.g. drawing frames) in the dif-
ferent installation directories will be converted from FIG to FGA by default during the installation. The data in
the original state will be saved in a folder (resp. a ZIP archive) in the scene and catalogue directory. The con-
verted files will be documented in a LOG file.

When creating an interface between HiCAD and HELiOS, you will be prompted to update the databases after a
new installation or an update installation. The search for and management of 2-D parts will only be possible
after conversion of the database and the existing .FIG files with the above mentioned tool.
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System Requirements
n HiCAD

l Compatibility Matrix for Interfaced Applications (HiCAD)

n HiCAD Spooler

n HiCAD with Pointcloud

n HELiOS Database Server

n HELiOS Vault Server

n HELiOS Client

l Compatibility Matrix for Interfaced Applications (HELiOS)

n HELiOS Spooler

n License Server

n HELiOS SmartSearch Server

n HELiOS Application Server

n Operation in Virtual Environments

n Further Requirements for Installation
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System Requirements for HiCAD
It is possible to obtain our software with workstations and monitors as end-to-end solution. Thus, it is ensured that
with the right configuration you get the most out of our software. As a matter of course, we undertake site install-
ation of the software and customize these in accordance with heterogeneous system environments of common
products. No matter how you decide: It is up to you which hardware components are to be used.

Minimum hardware requirements *

Computer Generally, all hardware can be used enacting current drivers of applicable OS.

Please note that for instance the graphic-card drivers support OpenGL command sequence.

Internet connection and adrive for the installationmedium.

Processor
(CPU)

Intel or AMD processor with SSE2 support

Main
memory

4 GB RAM

To achieve optimal performance for large assemblies, the system should possess significantly
more mainmemory than is considered sufficient for HiCAD at first glance.

This enables the hard disk accessing operations Buffer memory, Undo and Switch drawing to be
performed up to 4 times faster.

Hard disk approx. 10 GB free disk space

Graphics
card

Fully OpenGL 2.0 capable graphics card with at least 128 MB memory. You can use the
OpenGLCapabilityTester to check whether the OpenGL capabilities of your computer are suf-
ficient for HiCAD.

Screen
resolution

1280 x 1024

Other For the output of reports, e.g. Sheet Metal cost calculations, you require Microsoft Office Version
2010 or higher

There are no further requirements for the installation of the HiCAD Version with License Management; the legal
licensing check is performed during runtime.

Examples of suitable hardware components for HiCAD *

Computer: Fujitsu Desktop ESPRIMO P958/power

Processor (CPU): Intel® Core™ i7-9700 Processor, 12MB, 3.00 GHz bis 4.7 GHz

or equivalent processor

SingleCore Benchmarks that can be found on various websites may help you with the
choice of the processor.

Example:

https://www.cpubenchmark.net/singleThread.html

Mainmemory: 4 x 8 GB, DDR4, 2.400MHz (inkl. ECC)

If you work with very large CAD drawings you should use computers with more RAM.

Hard disk: 1 x 512 GB, SSD M.2, 2,5 inches

Graphics card: NVIDIA Quadro P1000 (4 GB) oder AMD WX3100 (4 GB)
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Examples of suitable hardware components for HiCAD *

Screen resolution: 1920x1080 Full HD

When working with a high screen resolution, resizing text ("Enlarge Text") is not recom-
mended.

Operating system: Microsoft Windows 10 (64Bit)

Other: For the output of reports, e.g. Sheet Metal cost calculations, you require Microsoft
Office Version 2010 or higher.

* When using the HiCAD Point Cloud module, you will need a significantly higher hardware configuration. This also
depends on the size of the project.

The interfaces that are available for the HELiOS Clientare listed in a Compatibility Matrix.

Please note:

n For the connection to Sentinel License Server, the Firewall of the UDP Port 5093 License Server must be
released for in- and outcoming connections; for the Windows Firewall, the port release is executed auto-
matically by activating the respective option in the installation program of the License Server.

n If you use network licenses, use the operating systems indicated in the System Requirements for the
License Server.

n Internet access is necessary for the computer/server via which the licenses are managed!

n In addition, you need one of the database systems listed under Hardware Requirements for the HELiOS
Database Server when using HELiOS.

Compatibility Matrix for Interfaces Applications (HiCAD)
Listed below you find an overview of the interfaces that are available for HiCAD:

HiCAD 2020 HiCAD 2019 HiCAD 2018

Operating system

Windows 10, 64 Bit

Windows 8.1, 64 Bit

Windows 8, 64 Bit

Windows 7, 64 Bit

PDM system

HELiOS 2020

HELiOS 2019

HELiOS 2018

HELiOS 2017 or older

Interfaces
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HiCAD 2020 HiCAD 2019 HiCAD 2018

LogiKal 11

LogiKal 10

LogiKal 9

PartSolutions 8 to 11

KISSoft 03/2017 up to 03/2019

CADClick 3.0

Microsoft Office *
* Limitations may occur in conjunction with VBA.

Office 2019

Office 2016

Office 2013

Office 2010

Browsers

Internet Explorer 9 - 11

Edge

Mozilla Firefox

Google Chrome
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System Requirements for the HiCAD Spooler
The system requirements for Spooler are identical to those for a normal HiCAD Client (please see System Require-
ments for HiCAD). The RAM should be at least as large as the RAM for the existing HiCAD Clients. The reason for
this is that the Spooler must be able to perform, besides automation tasks, various other tasks such as the con-
version of HiCAD drawings (to 3D-PDF or similar).The HiCAD Spooler runs on a separate Plot Server System.

In a combined operation of HiCAD and HELiOS, the HiCAD Spooler is driven by HELiOS Spooler. You can find fur-
ther instructions for installing HELiOS Spooler running on the same system as the HiCAD Spooler in HELiOS Help.

Besides the Client operating systems Windows 7, 8 and 10 you can also use the Server operating systems Windows
Server 2008 or Windows Server 2012. Whether a Server operating system needs to be used depends on the licens-
ing conditions for the Microsoft operating system that you use. The decisive factor is the number of permitted sim-
ultaneous device connections.

Windows 7, 8 and 10 allow 20 simultaneous connections. This will be sufficient for 20 Print Clients, if all of them are
actually running at the same time. Please note however that each connection from a non-HiCAD/HELiOS work-
station will reduce this number.

Please note:

The HiCAD Spooler runs on a separate Plot Server system.
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System Requirements for Point Clouds
The system requirements depend on the project size. For a project with 26 scan positions, a computer with Intel
Core i7-6920HQ CPU @ 2.90 GHz (4 physical cores), 32 GB RAM, NVIDIA Quadro M2000 (4 GB memory) and 1 TB
SSD works adequately.

Recommended hardware equipment when using the HiCAD Point Cloud module

Processor (CPU): Intel Core i7/i9/Xeon with more than 3 GHz, 8 physical cores

or AMD equivalent

Mainmemory: 64 GB RAM

Hard disk: 1 TB Solid State Drive + regular HDD

Graphics card: Dedicated, i.e. separately integrated, graphics card, OpenGL 4.3 or higher,
at least 16 GB RAM

Operating system: Microsoft Windows 10 (64Bit)

Please note:

Please note that the import of point clouds requires more RAM than using the point cloud in HiCAD.
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System Requirements for the HELiOS Database Server
The requirements with regard to the hardware primarily depend on the specifications given by the respective
RDBMS supplier (Microsoft / Oracle). Currently, following operating systems are supported:

HELiOS 2020 HELiOS 2019 HELiOS 2018

Microsoft SQL Server 2019

Microsoft SQL Server 2017

Microsoft SQL Server 2016

Microsoft SQL Server 2014

Microsoft SQL Server 2012

Microsoft SQL Server 2008

Microsoft SQL Server 2005

Oracle* Database Server 12c

Oracle* Database Server 11g R2

Oracle* Database Server 11g R1

Oracle* Database Server 10g

*With HELiOS 2022 (version 2700) onwards, Oracle is no longer supported as a database platform.

In addition, the following minimum requirements should be guaranteed for the mainmemory and hard disk:

HELiOS 2020 HELiOS 2019 HELiOS 2018

Main
memory

Additionally at least 4 GB mainmemory.

With an increasing database size the working memory should be enlarged in order to guarantee
optimal performance.

Hard disk Additionally at least 10 GB hard disk memory.

The actual demand depends on the size of the database.

Please note:

n The use of virtual servers is essentially possible. Please consider to grant sufficient performance within the
virtual environment.

n On the database server, HELiOS data base should be imported beforehand, for example via HELiOS Data-
base Creator, so that clients can connect with the database.
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n SQL Server Standard vs. SQL Server Express
As of late, the productive use of SQL Server Express is possible. Please note that SQL Express has limited
storage size (10 GB) for each data base and provides weaker performance than SQL Standard, especially
on powerful hardware. If well-equipped hardware is used for the server (multiple processors and plenty of
RAM), the SQL server thwarts the performance again. On regular desktop hardware the difference between
SQL Express and SQL Standard is smaller due to the accordance of express limits and system.
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System Requirements for the HELiOS Vault Server
The HELiOS Vault Server can either be installed as 32-Bit or 64-Bit application. The minimum requirements are as
follows:

HELiOS 2020 HELiOS 2019 HELiOS 2018

Processor
(CPU)

X86 or AMD64 Architecture with SSE2 Support

Main
memory

Additionally at least 1 GB mainmemory

Hard disk The required hard disk space depends on the volume of arising data use (files). A safety mar-
gin should be considered.

Operating sys-
tem

Microsoft Windows 7 or Microsoft Windows Server 2008 R2 or higher

Please note:

n If you work with only interfaces to HiCAD and/or Microsoft Office, the use of HELiOS Vault Servers is
optional. Other interfaces must be used in conjunction with the HELiOS Vault Server.

n The needed hard disk space can also be distributed onmultiple volumes.

n We recommend the use of RAIDs in order to ensure failsafe performance.
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System Requirements for the HELiOS Client
The HELiOS Desktop (Client) can either be installed as 32-Bit or 64-Bit application. The minimum requirements are
as follows:

HELiOS 2020 HELiOS 2019 HELiOS 2018

Processor (CPU) X86 or AMD64 Architecture with SSE2 Support

Mainmemory Additionally at least 2 GB mainmemory

Hard disk Additionally at least 2 GB free hard disk memory

Operating system Microsoft Windows 7 or Microsoft Windows Server 2008 R2 or higher

The interfaces that are available for the HELiOS Clientare listed in a Compatibility Matrix.

Please note:

n When interfacing the HELiOS Desktop with other applications, for instance with a CAD system or Office
product, please consider the minimum requirements of each systemmanufacturer.

n If you want to use an integrated viewer, the hardware requirements of respective viewer manufacturer
must be considered.

n Before you can use the HELiOS Client you require a HELiOS Database Server as well as an appropriately
configurated ODBC connection.
Documents (in .pdf format) describing the installation procedure for the database system and the import
and export of the database can be found in the Wiki.

n Current information for hardware requirements can be found via www.isdgroup.com at Support.

Compatibility Matrix for Interfaced Applications (HELiOS)
Below you find a list of possible interfaces for the HELiOS Client:

HELiOS 2020 HELiOS 2019 HELiOS 2018

CAD system

HiCAD 2020

HiCAD 2019

HiCAD 2018

HiCAD 2017

HiCAD 2016

HiCAD 2015 or older

AutoCAD 2021 (as of SP1)

AutoCAD 2020 (as of SP1)
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HELiOS 2020 HELiOS 2019 HELiOS 2018

AutoCAD 2019 (as of SP2)

AutoCAD 2018

AutoCAD 2017

AutoCAD 2016

AutoCAD 2015

AutoCAD 2014

AutoCAD 2013 or older

AutoCAD Mechanical
2021

(as of SP1)

AutoCAD Mechanical
2020

(as of SP1)

AutoCAD Mechanical
2019

(as of SP2)

AutoCAD Mechanical
2018

Important:

*As of Inventor version 2021.1 (or newer) can be used from HELiOS Version 2502.3 or 2600.1. The
reason for this is the bug in Inventor described here. 

Inventor 2021* (as of SP1)

Inventor 2020 (as of SP1)

Inventor 2019 (as of SP1)

Inventor 2018

Inventor 2017

Inventor 2016

Inventor 2015

Inventor 2014

Inventor 2013 or older

Navisworks 2021 (as of SP1)
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HELiOS 2020 HELiOS 2019 HELiOS 2018

Navisworks 2020 (as of SP1)

Navisworks 2016 - 2019 (as of SP1)

Navisworks 2015 (as of SP1)

SOLIDWORKS 2020

SOLIDWORKS 2019 (as of SP2)

SOLIDWORKS 2018

SOLIDWORKS 2017

SOLIDWORKS 2016

SOLIDWORKS 2015

SOLIDWORKS 2014

SOLIDWORKS 2013 or
older

CAE-SYSTEM

EPLAN Electric P8 Ver-
sion 2.8

(as of SP1)

EPLAN Electric P8 Ver-
sion 2.7

EPLAN Electric P8 Ver-
sion 2.6

EPLAN Electric P8 Ver-
sion 2.5

EPLAN Electric P8 Ver-
sion 2.4

Zuken E3 Version 2019 (as of SP2)

OFFICE

Office 2019 (as of SP1)

Office 2016

Office 2013

Office 2010

Office 2007 or older

The symbol does not always mean that the respective product is not compatible. It can also mean that the inter-
actions between this product and the HELiOS Client have not been sufficiently tested by the ISD yet.

Installation Notes 21 / 190

HiCAD and HELiOS



System Requirements for the HELiOS Spooler
Generally, the HELiOS Spooler is a 64 Bit application. The main memory should be at least as large as the main
memory for the utilized Client systems. This ensures that all data to be processed by the HELiOS Spooler (i.e. the
data transmitted from the Client systems to the HELiOS Spooler can be handled successfully.

HELiOS 2020 HELiOS 2019 HELiOS 2018

Processor (CPU) AMD64 Architecture with SSE2 support

Mainmemory Additionally at least 2 GB mainmemory

Hard disk Additionally at least 4 GB free hard disk memory

Operating system Microsoft Windows 7 or Microsoft Windows Server 2008 R2 or higher

Please note:

n The HELiOS Spooler runs on a separate Plot Server system. It is not possible to install the HELiOS Spooler
together with the HELiOS Desktop on the same system! Reasons for this are, for example, possible dif-
ficulties with the Office interface, since both the HELiOS Desktop and the HELiOS Spooler install Word and
Excel customizations. It is also not recommended to use the system on which the HELiOS Spooler is run-
ning as an occasional workstation. This is partly because it is assumed that the HELiOS Spooler is the only
instance of the system that starts print jobs.

n The HELiOS Spooler requires locally installed CAD, electrical engineering or Office applications for that plot
and conversion orders are carried out. Please note that the use of these applications requires respective
licenses and that the hardware requirements of each system supplier must be considered as well.

n The mainmemory should be at least dimensioned as large as the mainmemory of the client system
deployed. Thus it is guaranteed that the data (which is transferred from the client systems to HELiOS
Spooler) can be processed accordingly.

n Besides the client operating systems for Windows, the above mentioned server operating systems can be
used as well. It depends on the license terms for the Microsoft OS used by your company whether a server
operating system can be used or not. Here, the number of permitted simultaneous connections is deciding
here.
As of Windows 7, 20 simultaneous logins are approved. In this case, you need to assure that apart from the
current logins sufficient logins are available for each Client computer’s Print Client.
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System Requirements for the License Server
We use the Software Sentinel RMS© from gemalto© for licensing. The license server is in principal a 32 Bit applic-
ation.

The minimum requirement for running a license server is as follows:

HiCAD/HELiOS 2020 HiCAD/HELiOS 2019 HiCAD/HELiOS 2018

Processor (CPU) X86 or AMD64 Architecture.

Recommended: 2 GHz Processor

Mainmemory Additionally at least 1 GB mainmemory

Hard disk Additionally at least 2 GB free hard disk memory

Operating system Microsoft Windows 7 or Microsoft Windows Server 2008 or higher

Please note:

n The license server need not be installed on a separate server or server operating system.

n A static IP address is required for the correct operation of a license server. When using a virtual server, a
static MAC address is required.

n The license server must not be installed on the same computer with HELiOS Desktop, because both
products share system information with regards to the licensing.

n Internet access is needed for the license server due to activation and deactivation.
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System Requirements for the HELiOS SmartSearch Server
See hardware requirements for the HELiOS Vault Server.
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System Requirements for the HELiOS Application Server
Please contact our consulting in terms of hardware requirements and installation of HELiOS Application Server.
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Operation in Virtual Environments

HELiOS Client

Generally, the HELiOS Client can be operated on Virtual Machines (VM). If you use integrated viewers, the hardware
requirements of the respective viewer manufacturer must be considered.

The HELiOS Client can also be used as a terminal application.

HELiOS Spooler

Generally, the HELiOS Spooler can be operated on Virtual Machines (VM). However, limitations may occur with
regard to simultaneously installed CAD system, electrical engineering software or Office applications.

With regard to graphics functionality, performance and integration of printers, too, limitations may occur in virtual
environments.

License Server

The license management system based on Sentinel RMS© by the company gemalto© can, generally, also be used
in virtual environments.

Network licenses on Virtual Machines (VM)

If you want to use/activate/deactivate the network licenses on virtual machines, please observe the following
points:

n A static MAC address is required

n A static IP address is recommended or required when using Commuter Licenses

n Before copying or changing a virtual machine, deactivate the network licenses, since the UUID (Universal
Unique IDentifier) of the VM will change due to the copying process, and cannot be deactivated afterwards any
more. This also applies to the starting of the VM on a different host.
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Further Requirements for Installation
n Microsoft .NET Framework and Visual C++ Runtime Libraries need to be installed on the computer before

HiCAD/HELiOS can be used; these packages will be installed as part of the HiCAD/HELiOS installation if
required.

n The graphics cardmust support Open GL 2.0 or higher. If the hardware or driver does not support this standard,
there will be shown a warning message when installing HiCAD, and a compatibility mode will be used (with low
graphic performance).

n To be able to work with HELiOS, a database systemmust be available that has been prepared for HELiOS. For
this you require

l AMicrosoft SQL Database Management system on your Server,

l A HELiOS database imported with the HELiOS Database Creator and

l An ODBC connection on the Clients.

Documents (in .pdf format) describing the installation procedure for the database system and the import and export
of the database can be found in the Wiki.

Current information on system requirements can also be found on the Internet at https://www.isdgroup.com at Sup-
port.
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Installation
The installationmedium (e.g. DVD or ISO file) contains the installation files for:

n HiCAD

n HiCAD Online Help

n HiCAD Viewer

n HiCAD Spooler

n HELiOS Database Creator (required when creating a HELiOS database for the first time, and for importing or
exporting an existing database)

n HELiOS Vault Server

n HELiOS Client (HELiOS Desktop, Standalone)

n HELiOS Spooler

n HELiOS SmartSearch Server

n Trial Edition (Demo version)

n Education Edition (for students)

n Silent Installation

n Postscript printer driver (required for the output of multiple views in a PDF file)

Important note on the scope of installed modules!

The scope of modules that will be installed depends on the product that was purchased. This means that not all
modules described in the installationmanual may be included in your software version.

The DVD has been developed for Windows operating systems. When you insert the DVD, the HiCAD/HELiOS install-
ation wizard will be started automatically.

If the Autostart function has been deactivated in the operating system, or if you use an ISO file for the installation, it
is mandatory for the installation of HiCAD to start the setup.exe file from the root directory of the installation
medium; only in this way it is ensured that the version will recognize the operating system, and that the matching
HiCAD-/HELiOS version will be installed.

Please note:

n The HiCAD-/HELiOS versionmust be installed on the hard disk on your computer; a start from the DVD is
not possible.

n You can conveniently download the current HiCAD/HELiOS version in the Download Area of the ISD Wiki.

After running the setup.exe file, the following dialogue will be displayed:
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Click on the Standard Edition button. This will open the following selectionmask:

Leave this selectionmask open, so that you can select the desired components one after the other.
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Installation von HiCAD
To install HiCAD, start Windows. If Windows has already been started, close all other applications and start the
installation wizard. In the installation wizard, click on the Standard Edition button. This will open the following
selection mask. Leave this selection mask open, so that you can select the desired components one after the
other.

Click on the HiCAD and HELiOS button to start the installation.

Before using HiCAD/HELiOS, Microsoft .NET Framework and the Visual C++ Runtime Libraries must have been
installed on the computer; these packages will be installed as part of the installation if required.
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Please read this information carefully.

Select an installation directory.
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You can help us increase the user-friendliness of our products even further. To participate or terminate your par-
ticipation, please activate the corresponding checkbox.

In the dialogue window, our notice on collection of data for constant GUI optimization can be opened.

You can terminate your participation at any time by choosing Help > Customer Feedback, and activating the cor-
responding checkbox.
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Data Protection notice: Collection of Data for Constant GUI Optimisation

You can help us increase the user-friendliness of our products even further. If you participate, the ISD will col-
lect information on your use of our software, in order to detect trends and use patterns. This information will
then be used for a constant optimisation of our user interface, with the aim to make the operation of our soft-
ware as convenient and efficient as possible for our users.

The collected information

n Contains data on the functions that you used (frequency and chronological order).

n Contains a key enabling the identification of your computer. It does not contain any personal data, and will
not be used to detect your identity. The key will only be used to obtain data on the diffusion rate of cus-
tomer feedback. For instance, it is important to know whether a functionality has been used 100 times by 1
customer, or whether another function has been used only once by 100 customers etc.

n Will be automatically removed after transmission to the ISD. In case of a failed transmission (e.g. because
of network problems) the information will be automatically removed after 1 week at the latest when the pro-
gram has been re-launched.

n Will not cause a slowing down of the program operation.

The ISD will not

n Store your name, address, or any other personal data.

n Ask any further questions besides asking for your consent to the participation.

n Use the data for any other purposes than those described above.

n Contact you in any form in connection with your participation.

You can choose to participate when installing the product for the first time. To terminate your participation at a
later time, choose Help > Customer Feedback, and select the corresponding option.
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For different drawing areas HiCAD offers especially adjusted surfaces and configurations, e.g. for Mechanical
Engineering, Steel Engineering and Plant Engineering. These can be selected during the installation of HiCAD.

Depending on the parameter configuration the saved settings in the CSV file will be applied, too. The CSV file con-
tains information on e.g. which files (e.g. HiCAD part masks or template files for labels) should be copied into the
sys directory. In case of an update different system files in the HiCAD sys directory will be replaced – without further
inquiry – by file supplied in the HiCAD templates directory, which are specifically adjusted to the chosen modules
and activated checkboxes (e.g. DSTV or Management + BIM).

Via Extended Settings you can change the parameter configuration once more and select your own template files.

Select a module for the parameter configuration and click Next.

You can now start with the installation or modify the Extended Settings, e.g. for the user configuration, the cata-
logues, or HiCAD with HELiOS.

Please note the following important information:

If a network path is specified on the tabs User Configuration, Catalogue or LogiKal interface, please make
sure that not the connected network paths (e.g. H:\Data\HiCAD_Katalog) are specified here, but the direct
UNC paths to the respective server, e.g. \\Server01\Data\HiCAD_Katalog.

This is because the user, e.g. the system administrator performing the installation, in contrast to the user using
HiCAD, may not have connected the required network drives (in the above example: H:\). In such a con-
stellation, these paths cannot be set up correctly by the installation.

In contrast, UNC paths are available in the same form to both users - provided that both users have access.
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In the Configuration Database, customer-specific settings for various features such as dimensioning, annotations,
workshop drawing creation or fitting of vertical ladders are stored. When performing an update, customer-specific
settings can be applied. In addition, values that have not been modified by the user will automatically obtain the
updated pre-settings.

In the Parameter configuration you can modify previously activated default templates. Moreover, you can select
CSV files via Own templates. The settings stored in the CSV file, too, will be applied. In a CSV file it is, amongst other
things, specified which files (e.g. HiCAD part masks or template masks for annotations) are to be copied to the sys
directory. When performing an Update, various system files in the HiCAD sys directory will be replaced with the files
supplied in the HiCAD templates directory which have been designed especially for a working with the selected
module and the activated checkboxes (e.g. …DSTV or Management + BIM). The standard CSV files are located in
the templates directory of the HiCAD installation. CSV files are configuration templates that you can create and edit
with Microsoft Excel (please see Online Help).

Parameter configuration: No templates is activated by default in Parameter Configuration. You can also change
this setting subsequently, via the programs ..exe/ParKonfigComp.exe (for the workstation) and ..ex-
e/ParKonfigUser.exe (for the User).
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The execution of the CatalogueMaker serves the purpose of specifying which standard series are to appear in the
standard part catalogues (currently standard series are available for DIN, ISO, EN, ANSI and JIS); the selection of
standards in the CatalogueMaker only influences the display of standard parts, but not their availability; the avail-
ability is still controlled via license selection in the ISD License Manager.

In case of updates, the existing configuration will be applied, and the CatalogueMaker will not be started auto-
matically. If you want to add standards to the catalogues, the program can be called via Start > All Programs > ISD
Software und Systeme GmbH > Administration.
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In case of a new installation you can specify an arbitrary name for the system data source. In case of an update,
the existing data source will be offered. User and Password will be identical with the ODBC login.

If you use a Vault Server, activate the Vault Server checkbox. Enter the name of the Server in the Address input
field, and the Server Port of the Vault Server in the Port input field. You already entered both during the installation
of the Vault Server.

If you have not installed the Vault Server yet, you can do this now: Choose HELiOS Options > Database > General >

Vault Server and specify the connection. For activation youmust then restart the HELiOS Desktop.

During an update installation it will be checked whether the existing HELiOS version is newer than the one on the
DVD. If this is the case, the HiCAD installation will only update the non-HELiOS files. The HELiOS files are those
that would be supplied by a standalone installation of the HELiOS Desktop, minus the hicadcommons contained
therein.

If you want to process your print jobs via the ISD Plot Management, you need to install one PrintClient on each
workstation. Activate Use Spooler . In the Server field, enter the network name of the computer on which the
Spooler is installed. The Spooler collects the print jobs and processes them, taking your settings into account.

Individual settings of HELiOS can be distributed to other users or workstations. To do this, create a ZIP file in
HELiOS at View > Settings > Export.

During installation, if the option Use central directory for configuration data (across computers) is activated, you
can save the configurations of the HELiOS Desktop to a central computer and select and import them at Con-
figuration file.
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The availability of interfaces with HELiOS depends on the programs that are installed on your computer. You can
only link 32Bit versions to HELiOS 32Bit versions, and only 64Bit versions to HELiOS 64Bit versions. An exception is
the MS Office Interface, where you can link a 32 Bit Office to a 64 Bit HELiOS. Please note however that an addi-
tional, special ODBC connection will be required for old BOMs. In such cases, please contact the ISD Consulting
team.

Multiple selections of HELiOS Interfaces are also possible. The HELiOS functions will be integrated in the programs
that are linked to HELiOS.

Please note:

n Integration of shared networks
If a directory is accessed by more than one computer, in the filegrup.dat under C: (for the Scenes directory)
should not be listed a local path or the network connection letter, but the entire UNC path according to the
pattern C:\\servername\ShareName\Directory.
The filegrup.dat can be found in the HiCAD/HELiOS installation in the HiCAD exe directory and in case of
an EPlan interface as well under HELiOS EPlan SyncService\exe. In the HELiOS Standalone installation the
filegrup.dat can be found in the HELiOS exe directory.
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If you have installed LogiKal on your computer, you can enter the installation directory here.

Please note:

In HiCAD, at Settings > Further directories you can set the paths for the database of the Configuration
Editor, the Catalogue Editor and LogiKal. These paths are located in the Windows Registry at HKEY_LOCAL_
MACHINE\SOFTWARE\ISD Software und Systeme\HiCAD\nnnn.n . nnnn.n is the HiCAD version number,
e.g. 2500.0.

Installation Notes 39 / 190

HiCAD and HELiOS



The Activate license administration tools checkbox must be activated for the management of server licenses.

If you checkmark the Activate ISD Update Service option, a Hotfix will be searched on the ISD Web Server when
you start HiCAD. You can also activate this option subsequently via the Windows Control Panel: There, choose Pro-
grams and Features, right-click on HiCAD and choose Change.

Click Save to save the Extended Settings to an .ini file. If you place the .ini file in the installation directory when
installing server licenses, the settings will be applied.

As soon as you exit the Extended Settings dialogue with OK, the installation will be started.
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Click Install.
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Click Finish to complete your HiCAD installation. After successful installation you will find the HiCAD shortcut
on the Desktop of your computer for program start.

If desired, you can use the buttons of the installationmask to install further software components.
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Installation der Online-Hilfe
The Online Help is available locally (status of the date of installation DVD creation) and on the Internet (regularly
updated) at www.help.isdgroup.com/en/. Both versions of the Help can be directly launched from HiCAD/HELiOS.
Please note that corresponding login data are required to access the Internet version of the Help.

Start Windows to install the Help. If Windows has already been opened, close all other applications and start the
installation wizard.

In the installation wizard, click the Standard Edition button, which opens a mask with various selection options for
software components. Leave the selection mask of the installation wizard open, so that you can select the desired
components one after the other.

Click on the HiCAD and HELiOS Help button.
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Enter the installation directory for HiCAD/HELiOS.
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After successful installation, the Help can be found in the program folder and can be called from HiCAD/HELiOS

.
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Installing the HiCAD Viewer
The HiCAD Viewer enables you to view drawings in HiCAD format (*.sza, *.szx) and output these drawings (in non-
scale representation). This viewer is free of charge and may be provided free, without changing the scope of deliv-
ery.

Start Windows to install the HiCAD Viewer. If Windows has already been opened, close all other applications and
start the installation wizard.

In the installation wizard, click the Standard Edition button, which opens a mask with various selection options for
software components.

Leave the selection mask of the installation wizard open, so that you can select the desired components one after
the other.

Click on the HiCAD Viewer button.
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Enter the installation directory for the software.
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Click Install.

Click Finish to complete the installation of the HiCAD Viewer. You can now install further components from the
selectionmask.
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Installation des HiCAD Spoolers
Start Windows to install the HiCAD Spooler. If Windows has already been opened, close all other applications and
start the installation wizard.

In the installation wizard, click the Standard Edition button, which opens a mask with various selection options for
software components.

Leave the selection mask of the installation wizard open, so that you can select the desired components one after
the other.

Click on the HiCAD Spooler button.
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Please read this information carefully.

Enter the installation directory for the software.
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You can now either begin with the installation or open the Extended Settings, for example to modify the user con-
figuration or catalogues. You canmodify the Extended Settings as you would do for a HiCAD installation.

Click Install.

After successful installation, the HiCAD Spooler can be found in the program folder.
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Installing the HELiOS Database Creator
The HELiOS PDM modules (Document management, Part Management, Workflow etc.) are based on a relational
database. Before you put HELiOS into operation, the Microsoft SQL Server database administration system needs
to be installed on the server, a HELiOS database needs to be imported and a ODBC connection needs to be set up
on the clients.

When you set up a HELiOS database for the first time, the HELiOS Database Creator needs to be installed and
executed on the database server first. The database and table structures will then be created, and filled with data
records of the HELiOS standard database.

Please note:

Further information about the correct procedure for the execution of the HELiOS Database Creator, as well as
the previous and subsequent steps required for the setting up of a database server can be found in the user
guide for the installation of the Microsoft SQL Server. You can find this document in the ISD Wiki.

Start Windows to install the HELiOS Database Creator. If Windows has already been started, close all other applic-
ations and start the installation wizard.

Click on the Standard Edition button. This will open the following selectionmask.

Leave this selectionmask open, so that you can select the desired components one after the other.

Click on the HELiOS Database Creator button.
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Select an installation directory for the HELiOS Database Creator and click Next.
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Click Install to start the installation.

Click Finish to complete the installation of the HELiOS Database Creator. If desired, you can now install further
components via the selectionmask.
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Installing the HELiOS Vault Server
Please start Windows to install the HELiOS Vault Server. If Windows is already open, end all other applications and
start the Installation Wizard.

Click on Standard Edition.The screen with the software components then appears.

This screen remains open so that you can install the required components one after another.

Please note:

In rare cases, a manually installed older version of the Vault Server may be found which is not touched
(updated) by the setup for safety reasons. In case of an error message, please contact our hotline staff. E-Mail:
support@isdgroup.com

Click on the Vault Server button.

Installation Notes 55 / 190

HiCAD and HELiOS

mailto:support@isdgroup.com?subject=Vault Server


Enter the installation directory for the Vault Server.
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Give the Vault Server a name, e.g. the name of your company, plus the location of your company. This name will be
shown, for example, when you connect to the Vault Server from the Vault Client.

The Vault Server renames all documents that are managed in the database (e.g. SZA, DOC, XLS, …) to *.VDF.
These VDF files are saved to the Document directory.

The files stored in the Management directory contain the assignments of the VDF file names to the “original file
names”.
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Log files (*.LOG) are saved to the Log directory. They record each access to the VDF files.

Enter the name of the log file in the Log file name field. The name of the Vault Server would also be possible here.
If the log file exceeds a certain length, it will be cut down and suffixed by the current date.

Click Install.
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Click Finish to complete the installation of the Vault Server. You can now install further components from the selec-
tionmask.
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Installing the HELiOS Client
The HELiOS Client is normally automatically installed during the HiCAD installation. But of course, you can also
install HELiOS separately. To install HELiOS, start Windows. If Windows has already been started, close all other
applications and start the installation wizard.

In the installation wizard, click on the Standard Edition button. This will open the following selection mask. Leave
this selectionmask open, so that you can select the desired components one after the other.

Click on the HELiOS button.

Before using HELiOS, Microsoft .NET Framework and the Visual C++ Runtime Libraries must have been installed
on the computer; these packages will be installed as part of the installation if required.
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Please read this information carefully.

Select an installation directory.

In accordance with the current Microsoft guidelines, the HELiOS documents will be saved to C:\User-
s\Public\Documents\ISD Software und Systeme\ in case of a new installation. Only the Administrator has write per-
missions for the installation directory (C:\ProgramFiles\..).
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If you work on several workstations without a Vault Server, you need to enter on each workstation the path of the
document directory into the system file FILEGRUP.DAT. This means that the default path needs to be changed
accordingly in all corresponding places of the FILEGRUP.DAT. The directory should be a shared network directory
to which all Clients have access.

Please read these important notes on update installations for Inventor, AutoCAD and SOLIDWORKS carefully and
activate the checkbox . Further information can be found here.
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Please read the Notes on Hardware Exchange carefully.

Harware Exchange

If you use local HiCAD/HELiOS licenses and want to exchange any hardware components, modify the par-
titioning of, or re-install the operating system, you need to revoke the existing license on the HiCAD/HELiOS
workstation first, and request, using the new hardware or modified configuration, a new license key (further
information on the procedure can be found in the software documentation).

If a revocation is technically possible, but will not be performed, the ISD reserves the right to charge costs in an
appropriate amount for the reissuing of the license. If the license will not be revoked, or if such revocation is no
longer technically possible, the ISD may request proof that the unrevoked license is no longer utilisable; in
case of failure to produce such proof, the ISD reserves the right to refuse the transfer of the license to a new
hardware.

Accept the notes to continue with the installation.

You can now start with the installation or modify the Extended Settings for HELiOS.
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In case of a new installation you can specify an arbitrary name for the system data source. In case of an update,
the existing data source will be offered. User and Password will be identical with the ODBC login.

If you use a Vault Server, activate the Vault Server checkbox. Enter the name of the Server in the Address input
field, and the Server Port of the Vault Server in the Port input field. You already entered both during the installation
of the Vault Server.

If you have not installed the Vault Server yet, you can do this now: Choose HELiOS Options > Database > General >

Vault Server and specify the connection. For activation youmust then restart the HELiOS Desktop.

If you want to process your print jobs via the Plotmanagement of the ISD, you need to install a Print Client on each
workstation. Activate Use Spooler . In the Server field, enter the name of the computer on which you install the
Spooler. The Spooler collects the print jobs and processes them according to your settings.

Individual settings of HELiOS can be distributed to other users or workstations. To do this, create a ZIP file in
HELiOS at View > Settings > Export.

During installation, if the option Use central directory for configuration data (across computers) is activated, you
can save the configurations of the HELiOS Desktop to a central computer and select and import them at Con-
figuration file.
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The availability of interfaces with HELiOS depends on the programs that are installed on your computer. You can
only link 32Bit versions to HELiOS 32Bit versions, and only 64Bit versions to HELiOS 64Bit versions. An exception is
the MS Office Interface, where you can link a 32 Bit Office to a 64 Bit HELiOS. Please note however that an addi-
tional, special ODBC connection will be required for old BOMs. In such cases, please contact the ISD Consulting
team.

Multiple selections of HELiOS Interfaces are also possible. The HELiOS functions will be integrated in the programs
that are linked to HELiOS.

Please take a look at the Compatiblity Matrix.to check which interfaces to external software products are supported
by HELiOS.
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The Activate license administration tools checkbox must be activated for the management of server licenses.

Click Save to save the Extended Settings to an .ini file. If you place the .ini file in the installation directory when
installing server licenses, the settings will be applied.

Close the Extended Settings dialogue with OK.
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Click Install.
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After successful installation, you will find the HELiOS shortcut on the Desktop of your computer for program
start.
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Installing the HELiOS Spooler

Important installation notes - please read carefully!

As the HELiOS Spooler (as of HELiOS 2015, V 2000.0) is an entirely new software, an update of the old Spooler
is not possible. Before installing the new HELiOS Spooler, please make a record of the old Spooler’s settings,
uninstall it, and then adjust the settings of the new Spooler accordingly.

Further information can be found in the HELiOS Online Help.

The HELiOS Spooler is only available as a 64Bit version, and supports only 64Bit applications.

Start Windows to install the HELiOS Spooler. If Windows has already been opened, close all other applications and
start the installation wizard.

In the installation wizard, click the Standard Edition button, which opens a mask with various selection options for
software components.

Leave the selection mask of the installation wizard open, so that you can select the desired components one after
the other.

Click on the HELiOS Spooler button.
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Enter the installation directory for the software.
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In the Service registration area you can choose between the options Local system and User account.

A part of the Spooler is started by the system as a background process (Windows service). For safety reasons it is
recommended to create a Windows User account, with User name and Password with read and access per-
mission, before installation.

If you do not know the user yet, you can choose Local system. The Spooler will then run, initially without access to
any printers, as a simple Windows system service. Now, select Control Panel > Administrative Tools > Services.
Right-click HELiOS Spooler and select Properties. On the Log On tab, switch to This account and enter the User
name and the Password.

Important:

If the Spooler user's password later changes or expires, the passwordmust be reassigned to the HELiOS
Spooler service in the Windows Control Panel at Management > Services via Right-click > Properties > Log
On.

If the Start service upon installation option is active, the Spooler service will not require a manual start after install-
ation.

Normally, the HELiOS Spooler runs as a Windows Service in the background. In this standard configuration the
Spooler process will be started by the operating system in a special session which is not visible for the user. There-
fore, the process will even continue running after the Spooler user has logged off from the computer. Unfortunately,
internal tests have found that problems may occur with this type of operation in conjunction with some CAD sys-
tems; currently this applies in particular to the interface with SOLIDWORKS.

If you are considering using the HELiOS Spooler together with SOLIDWORKS, we therefore recommend choosing
the Start in interactive mode option during installation in order to avoid problems. When this option has been selec-
ted, the Spooler will no longer be set up as a service, but will be started directly in the foreground via the Admin-
istration UI. During this type of operation, the Spooler process will appear in the form of a small text window in the
window bar (Caution: When you log off from the Server, the Spooler process will also be ended here!)
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For starting the “interactive” configuration of the Spooler automatically, the file Helios.Spooler.exe from the install-
ation directory must be invoked with the option “—no service”, for instance, either from the “Autostart” folder or via
Windows task planning. If you have further questions, please contact our ISD Consulting team.

Select the data directory. Activate the Create network share checkbox to enable the communication with the
PrintClient. If the network share is not created during installation, it must be created manually afterwards. Since
special settings will be required here, we recommend contacting our Consulting team.

Choose the CAD system that you want to link to the HELiOS Spooler, and click Next.

In this dialoguie window you will be asked for the login of the database user, which is the login of the (SQL) data-
base system.

Under System data source youmust then select the corresponding ODBC database connection. The HELiOS User
via which the Spooler will run is also selected here. It is important that this user has administration rights and is also
assigned to the HELiOS Group "PDM Administrators" at this point. Otherwise you will receive an error message.

Activate Use Vault Server and enter the Address and Port of the Vault Server installed in the system for your
MultiCAD operation.

Click Next.
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Click Install.

Click Finish to complete your installation.

After successful installation, the HELiOS Spooler can be found in the program folder.
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Installing the HELiOS SmartSearch Server
The SmartSearch in HELiOS allows a quick retrieval of parts, documents, folders and projects by means of a (also
object-) comprehensive meta data and full text search.

To be able to use the SmartSearch , you need to install an index server, the so-called HELiOS SmartSearch
Server , on your system. The only requirement for installation is Java Runtime Environment. If no Java Runtime
Environment has been installed on the Server yet this needs to be done now.

Please note:

The SmartSearch functions have to be activated by a registry entry per each workplace. For this, the provided
file EnableSmartSearch.reg from the installation directory HELiOS SmartSearch can be executed on the
respective computer.

Start Windows to install the HELiOS Smart Search Server. If Windows has already been opened, close all other
applications and start the installation wizard.

In the installation wizard, click the Standard Edition button, which opens a mask with various selection options for
software components.

Leave the selection mask of the installation wizard open, so that you can select the desired components one after
the other.

Click on the HELiOS SmartSearch Server button.

If Java Runtime has not been installed on your system yet, this must be done prior to the actual installation.

74 / 190 Installation Notes

Installation



Enter the installation directory for the HELiOS SmartSearch Server and click Next.
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Click Install.

Click Finish to complete your installation.
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Installing the Trial Edition (Demo Version)
The Trial Edition (Demo version) has a changed data format, which allows a reading of data out of the Standard Edi-
tion, but not a writing of data back to it (i.e. in a Standard Edition the data format of special versions is not read-
able!). For printouts, plot stamps will always be output.

Please note:

The license is free and valid for 30 days from the date of installation. Its transfer to other computers after its
activation is not possible.

Start Windows to install the HiCAD Spooler. If Windows has already been opened, close all other applications and
start the installation wizard.

In the start mask of the InstallationWizard, click Trial Edition.

Before using HiCAD/HELiOS, Microsoft .NET Framework and the Visual C++ Runtime Libraries must have been
installed on the computer; these packages will be installed as part of the HiCAD installation if required.
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In the Welcome... window, click Next.

Enter the activation data for product activation and click Next.

To obtain the activation data, please fill in the form on our website at isdgroup.com.
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Install the program to the ...\Trial Edition folder.

Click Install.
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Click OK to complete the installation.
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Installation Education Edition (for Students)
The Education Edition (Student Version) is a fully functional standard version. The license is free and valid for 1 year
(365 days). It can be activated and deactivated with the ISD License Manager, which will be available after install-
ation (see Chapter 7.3).

The drawings (.-SZA) and parts (.KRA) created with Education Edition can not be loaded with the Standard Edition.
In case if a file (.SZA or .KRA) created with the Education edition is opened with a Standard Edition, an appropriate
message will be sent. The title bar of the HiCAD interface will show the text HiCAD Education Edition: Not for com-
mercial purposes.

If the Autostart function has been switched off in the operating system, you must run the setup.exe file in the root
directory of the DVD for installation. Only in this way will be ensured that the version of the operating system will be
correctly recognized and that the correct HiCAD version will be installed.

Click on the Education Edition button.

Before using HiCAD/HELiOS, Microsoft .NET Framework and the Visual C++ Runtime Libraries must have been
installed on the computer; these packages will be installed as part of the HiCAD installation if required.
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Click Next to start the installation.

Enter the activation data for product activation and click Next.

To obtain the activation data, please fill in the form on our website at isdgroup.com and upload your student identity
card or your matriculation certificate.

82 / 190 Installation Notes

Installation

https://www.isdgroup.com/en/testen-und-kaufen/hicad/stundentenversion/


Select an installation directory.

Click Install.
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Click OK to complete the installation.
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Silent Installation
The silent installation can, for example, be configured for HiCAD, HELiOS or the HELiOS Spooler. The procedure is
always the same.

To configure the installation options, start the installation setup.exe as usual andmake the required settings.

In the last dialogue of the installation, click on Extended Settings.

Here you can configure in particular the settings for the and the Catalogues in such a way that user interactions will
no longer be required.
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The parameter configuration takes place via selection of the .CSV file.

For Execute CatalogueMaker, the Interactive checkbox must been deactivated.

Clicking Save creates a setup.ini file containing the desired settings. This file will be loaded automatically if it is loc-
ated in the same directory as the Windows Installer package HiCAD.msi. Alternatively you can specify a file via the
command line:
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setup.exe SETTINGS="<Ini-Datei>" /l*v "<Log-Datei>"

or

msiexec /i HiCAD.msi SETTINGS="<Ini-Datei>" /l*v "<Log-Datei>"

In this case the starting will not be “silent”, i.e. the installation dialogues will appear, but with the default values of
the .ini file.

The option /l*v "<Log-Datei>" creates a log file of the installation which can be used for the diagnosis of installation
problems.

Redistributables
Before distributing the installation you need to install the required redistributables on the target systems in order to
circumvent the Microsoft-EULAs.

Examples:

vcredist.exe /passive

dotNetFx40_Full_x86_x64.exe /passive

The respective command line options of the individual Redistributable Installer can be called via the command line
option /?.

If required, the .msu files of the Windows Installer 4.5 can be installed with the Windows Package Manager pkg-
mgr.exe (http://support.microsoft.com/kb/934307/en).

The packages can be installed with /passive /norestart. Otherwise, a reboot would be initiated automatically. If a
package requires a reboot, the return value is 3010; otherwise it is 0 or an error code.

Please note:

n You need to install the redistributables that are located on the DVD at Program32 or Program64 (except for
the setup.exe and the language-specific folders such as de-de).

n The utilisation of the msi package or the setup.exe, respectively, differs insofar as the setup.exe will issue
an interactive message if a requirement (redistributable) is missing, while the msi package will cancel the
process with an error code. The latter might be more suitable for a deployment within the scope of a soft-
ware distribution program.

Starting the installation in the silent mode
The installation can only be set to the silent mode via the command line:

setup.exe SETTINGS="<Ini-Datei>" /passive /l*v "<Log-Datei>"

or

msiexec.exe /i HiCAD.msi /qb!- /SETTINGS="<Ini-Datei>" /l*v "<Log-Datei>"

As neither dialogues nor error messages are displayed, /l*v "<Log-Datei>" creates a log file of the installation which
can be used for the diagnosis of installation problems.

Installation Notes 87 / 190

HiCAD and HELiOS

https://support.microsoft.com/de-de/help/934307/description-of-the-windows-update-standalone-installer-in-windows


Information on further command line options can be obtained via the command line, by means of the command
msiexec /? , and via the Internet at

http://technet.microsoft.com/en-us/library/ cc759262%28WS.10%29.aspx#BKMK_SetUI

http://msdn.microsoft.com/en-us/library/windows/desktop/ aa372024%28v=vs.85%29.aspx

Example: Batch installation incl. Redistributables and Log
@set SOURCE=\\entw042\Setups\HiCAD 2500

"%SOURCE%\vcredist_x86_10.0.40219\vcredist_x86.exe" /passive /norestart

@if errorlevel 1 echo Fehler bei Visual C++ Runtime Installation && goto error

"%SOURCE%\DotNetFX40\dotNetFx40_Full_x86_x64.exe" /passive /norestart

@if errorlevel 1 echo Fehler bei .NET Installation && goto error

msiexec.exe /qb!- /i "%SOURCE%\de-de\HiCAD.msi" /l*v "%SOURCE%\logs\%COMPUTERNAME%_HiCADIn-
stallLog.txt" SETTINGS="%SOURCE%\Config\setup.ini"

@if errorlevel 1 echo Fehler bei HiCAD Installation && goto error

@exit

:error

@echo Installationsfehler %errorlevel%

@net helpmsg %errorlevel%

@pause
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Configuration
Company- or user-specific requirements can be conveniently adapted to the configration.

n ConfigurationManagement HiCAD

l ConfigurationManagement for Updates

l ConfigurationManagement for New Installations

n Parameter Configuration for HiCAD

n Configuration HELiOS (Central Distribution of Settings)
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Configuration Management
HiCAD offers a central configurationmanagement with the Configuration Editor. This tool allows the creation of cus-
tomer-specific configurations for a wide range of tasks, such as dimensioning, annotation, workshop drawing cre-
ation, fitting of vertical ladders etc. Once adjusted to company-specific requirements, these configurations can
directly be used in HiCAD, without having to specify any further settings. The aim of our further developments is a
gradual transfer of the previously used system files with their adjustable parameter settings into the Configuration
Editor, thus enabling a central and safe configurationmanagement.

This transfer has already been realised for the following files:

n ALGPAR.DAT (as of 1800.0)

n BEMPAR.DAT (as of 1800.0)

n DIMENSIONING_SETTINGS.XML (as of 1800.0)

n KRPGEN.DAT (as of 1801.0)

n MASPAR.DAT (as of 1801.0)

n FITTABLE_SETTINGS.XML (as of 1801.0)

n STBEMPAR.DAT (as of 1801.0)

n TXTANSI.DAT (as of 1801.0)

n STABMPAR.DAT (as of 1802.0)

n AUBM3PAR.DAT (as of 1802.0)

n ALG3DPAR.DAT (as of 1901.0)

n FEATURE.DAT (as of 1901.0)

n SCHRIF.DAT (as of 1901.0)

n TXTFONT.DAT (as of 1901.0)

n LINPAR.DAT (as of 1901.0)

n SSWRITESTEP.DAT (as of 1901.0)

n PASSTAB.DAT (as of 2000)

n ANSGEN.DAT (as of 2100)

n PARAMASS.DAT (as of 2101)

n SSTINI3D.DAT (as of 2102)

n SSTINI.DAT (as of 2102)

n STB_PARAMETER.DAT (as of 2102)

n GRAPAR.DAT (as of 2201)

n KNTPAR.DAT (as of 2202)

n REF3D_ATTR_AKT.DAT (as of 2300)

n TXTPAR.DAT (as of 2300)

n TPAR.DAT (as of 2400)

n ABWPAR.DAT (as of 2402)

n ABWCOL.DAT (as of 2402)

n ABWPOL.DAT (as of 2500)
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The settings from these files have been integrated into the Configuration Management. In the Online Help for the
Configuration Management you will find the document schluesselnamen.pdf , which shows you where you can
retrieve the entries from the DAT files in the Configuration Editor.

In addition, the Online Help provides a description of various scenarios for the utilisation of the tool. An extensive
description of the Configuration Management (Performance – Functions – Scenarios) is provided in the document
ISD-Configuration.pdf.
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Configuration Management for Updates
When performing an update from HiCAD 2019 or HiCAD 2018, your settings from the existing configuration file
HICAD.CFGDB of your previous HiCAD version will be transferred to the Configuration Management of HiCAD
2020, namely into the Administrator profile.

When the update is performed, only the values predefined by the ISD, i.e. the “factory settings”, will be changed.
All other (administrator or user) settings will be preserved.

If you use a central configuration database on a server, it will be automatically detected by the update program by
means of the aforementioned Registry entry, and will be updated. For an update of several workstations, one single
update will be sufficient; a multiple update will, however, not do any harm either (as an already updated setting will
not be updated again).

When HiCAD is started, the configuration database will be checked.

n If HiCAD is started with an outdated configuration base, a corresponding message will be displayed. In this
case, please perform an update of the configuration database in order to avoid error messages or unexpected
behaviour.

n If HiCAD is started with the database of a newer Major Release, a corresponding message will be displayed. In
this case, please use a compatible database to avoid error messages or unexpected behaviour.
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Configuration Management for New Installations
If you perform a (new) installation of HiCAD 2020, the settings predefined by the ISD will be initially used in the
Administrator profile of the Configuration Management. If you want to transfer your individual settings in the file
HICAD.CFGDB from HiCAD 2019 or HiCAD 2018 to the Configuration Management of HiCAD 2020, use the pro-
gram CfgDbTool.exe in the HiCAD EXE sub-directory for this.

Furthermore, you are enabled to transfer settings from old DAT and XML files which are now managed in the Con-
figuration Editor, to the configuration database of the current version.

Start the CfgDbTool.exe from the HiCAD / exe sub-directory

Use the Update tab of the CfgDBTool you tab to transfer the settings of your previous configuration file (.CFDB) to
the configuration file.

Installed
database

The configuration database to be updated, i.e. (the configuration database of your previous
HiCAD.

Update
source

The configuration database of the new version; the configuration database with the current ISD
settings can be found in the folder: [HiCAD installation directory]\Configuration.

Update
target

The result of the update. If you enter the same file here as in the Installed database, a backup of
the previous configuration database will be created. You cannot enter the same database here
that you entered in the Update source field.

Select the directories.

Click the Update button to start the process.

Use the Migrate tab to transfer your individual settings from old DAT and XML files which are now managed in the
Configuration Editor, to the configuration database of HiCAD 2019.

The setting files with their adjustments need to be copied to the HiCAD SYS subdirectory of the new HiCAD version
for this purpose.

Start the CfgDbTool.exe from the HiCAD / exe sub-directory and activate the Migrate tab.
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HiCAD
base
folder

Here you enter the directory where your old DAT and XML files etc. are located. Please make sure
that the old files have the same name and are located in the same directory structure as in a
HiCAD standard installation.

Target
database

Here you specify the database to which the data are to be transferred.

Select the directories.

Click the Migrate button to start the process.
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Parameter Configuration for HiCAD

Important update notes - please read carefully!

When you run the Computer Parameter Configurator (HiCAD exe\ParKonfigComp.exe) tool – either during the
installation/update (Extended Settings > User Configuration tab) or later – the following message will be dis-
played.

After confirming with OK, various system files in the HiCAD sys and szenen directory will be replaced with the
files supplied in the HiCAD templates directory which have been designed especially for a working with the
selected module and the activated checkboxes (e.g. …DSTV or Management + BIM). These files include, for
example

n HiCAD masks for the part attributes (*.HDX),

n HELiOSmasks for projects, documents and articles (*.XML, *.MSK),

n Various configuration files (*.HDB) and

n Template files for annotations (*.FTD).

You should therefore always make backups of all files that you have customized before using the ParKon-
figComp.exe tool! If you have any questions, please contact your nearest ISD branch office.

Cancel aborts the operation without any changes to the configuration.

HiCAD provides suitably customised interfaces and configurations for various fields of engineering, e.g. for Mech-
anical Engineering, Steel Engineering, Metal Engineering or Plant Engineering. You can select these options during
the installation of HiCAD.

To change the parameter configuration subsequently, start the programs

n ..exe/ParKonfigComp.exe for the workstation configuration, and

n ..exe/ParKonfigUser.exe for the user configuration.

Depending on the selection in the Parameter configuration, the settings stored in the CSV file, too, will be applied.
In a CSV file it is, amongst other things, specified which files (e.g. HiCAD part masks or template masks for annota-
tions) are to be copied to the sys directory.

When performing an Update, various system files in the HiCAD sys directory will be replaced with the files supplied
in the HiCAD templates directory which have been designed especially for a working with the selected module and
the activated checkboxes (e.g. …DSTV or Management + BIM). The standard CSV files are located in the tem-
plates directory of the HiCAD installation. CSV files are configuration templates that you can create and edit with
Microsoft Excel.
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In the dialogue window you have the following setting options:

n Module
Here you choose the required filed of engineering. The commonHiCAD parameters are then configured for this
area.

n Font
Specifies the text font default setting, e.g. for dimensioning, title blocks, view labelling, annotation etc.

n Attribute configuration according to DSTV
If you want the HiCAD attribute masks for parts and drawings to obtain the DSTV-relevant attributes, please
activate the appropriate checkbox. The files BRW_3DTEIL.HDX and BRW_SZENE.HDX in the HiCAD SYS dir-
ectory will be preset for DSTV BOM configuration.

n HiCAD/HELiOS Default Solution
Provides you with a preconfigured database solution for a safe and convenient management of product data. If
you want to use it, activate the checkbox.

n Novice Configuration
If you want HiCAD to be preset so that the automatic procedures of the novice configuration apply, activate this
checkbox.

n Management + BIM
Provides the BIM-PDM configuration with typical civil engineering attributes, masks and title blocks.
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n User-defined template
Activate this option if you want to use your own configurations. Then select the relevant configuration file.

Please note:

When performing an update, only activate the copying of default templates if no user-specific, customized
masks and Bills of Materials are used.
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Configuration HELiOS (Centrale Distribution of Settings)
During installation of HELiOS you may either import the HELiOS settings (e.g. user interface, masks and attribute
assignments) as a ZIP package as usual or provide them locally (in a network folder). HELiOS then checks for
newer settings when the application is started and updates the local settings accordingly.

The optional request for UI configuration during a New, Update or Change Installation has been extended in
HELiOS 2020. It is now possible to distinguish between a local and a central (cross-computer) directory. This means
that you can save the HELiOS configuration for several workstations in a central directory instead of having to "dis-
tribute" it to the individual local directories. To do this, create a ZIP file in HELiOS under View > Settings > Export.

If you select the option Use central directory for configuration data in the new or update installation, a directory

(e.g. network drive) must be selected via Windows Explorer instead of the local Configuration filein .ZIP format.
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Change Installation

A Change Installation from HiCAD-/HELiOS offers the option to change a central configuration subsequently.
However, a subsequent selection of a local Configuration file is not required here. If would like to change the con-
figuration file subsequently, use the HELiOSConfigImport.exe tool.

Please note:

n Settings files that are provided by the administrator in a central directory must be selectively copied to that
directory. The directory structure provided by HELiOS must be observed due to the dependency on files.
This must correspond to the directory structure defined in %APPDATA%\ISD Software und
Systeme\HELiOS 2020. If in doubt, contact the ISD consulting team if you have any further questions.

n If the set configuration directory is not accessible at runtime, HELiOS behaves as if it is empty. This means
that the program starts without updating the interface configuration.

n During the update installation of HELiOS for an older HiCAD version (before 2020), the option for setting
the configuration directory is missing and can only be adjusted via the registry. If you have any questions,
please contact the ISD consulting team.

n When updating an older HELiOS to HELiOS 2020 or higher, old mask files (in the \sys\ directory of the
installation) are converted to the new XML format during the process and saved under%Program Data%.
This conversion is not dependent on whether the local or central directory was selected for the interface
configuration. The old configuration file can then be found in a backup directory created by the operation
below the installation folder.
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n The new masks at %Programdata% should not be overwritten in any case, because these are the "delivery
status", whichmay be updated by later update installations. If masks are edited and changed with the
mask editor, they are stored at %Appdata% and are called up by HELiOS when working in corresponding
masks from this directory. This means: If masks are to be distributed uniformly to different workstations,
they must be saved under%Appdata% and not (!) under%Programdata%
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Update
n Licensing in Case of Updates

l Updating the Server License

l Updating Local Licenses

n Carrying Out the Installation

n Data Compatibility of HiCAD/HELiOS

n Update of HiCAD

l BackupsBefore Performing the HiCAD Update-Installation

l Update Installation of HiCAD

n ISD Update Service

l Installing the ISD Update Service

l Using the ISD Update Service

l ISD Update Service: Settings

n Updating the HELiOS Database (Database Schema)

n Mask Converter for HELiOS

n Manual Registration of Multi-CAD Add-ins

n New File Format for 2-D Files in HiCAD

l Installing the FIG-FGA Converter

l Conversion of 2-D Files into FGA Format

n CatalogueMaker

Important notes on updates!

Harware Exchange

If you use local HiCAD/HELiOS licenses and want to exchange any hardware components, modify the par-
titioning of, or re-install the operating system, you need to revoke the existing license on the HiCAD/HELiOS
workstation first, and request, using the new hardware or modified configuration, a new license key (further
information on the procedure can be found in the software documentation).

If a revocation is technically possible, but will not be performed, the ISD reserves the right to charge costs in an
appropriate amount for the reissuing of the license. If the license will not be revoked, or if such revocation is no
longer technically possible, the ISD may request proof that the unrevoked license is no longer utilisable; in
case of failure to produce such proof, the ISD reserves the right to refuse the transfer of the license to a new
hardware.

Licenses

Before updating HiCAD/HELiOS 2019 or 2018 to HiCAD/HELiOS 2020 you must deactivate all licenses (Server
Licenses or Local Licenses). The procedures for Server Licenses and Local Licenses are different.
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Data compatibility

HiCAD 2020 uses a different data format, which means that.SZA files saved with HiCAD 2020 can no longer be
loaded into older HiCAD versions.

When performing a HELiOS update, the update start mask shows you the HELiOS subversion, which needs to
match the existing database. If this is not the case, only an error message will appear when you start HELiOS.
To update the database schema, use the program HeliosDbUpdate.exe. If the database schema requires an
update, you can no longer access the database with older HELiOS versions. Therefore, all workstations
accessing the database need to be readjusted accordingly at the same time.

Administrator

Before carrying out an update you should inform the responsible Administrator to ensure a well coordinated
switch to the higher version.

Backup HiCAD/HELiOS

Backups of the following files must be made, for cases in which an unexpected interruption of the update
occurs: Catalogues, HiCAD.cfgdb (Configuration Database) and HELiOS Database (only required if you actu-
ally use a HELiOS Database).

HELiOS Data base schema

As existing datasets with non-compliant conditions may cause conflicts during the central update process of
the HELiOS delivery database, you should consider the following:

1. Do a database backup: You shouldmake sure that a backup of your HELiOS database has been created
before the update. This can be done with the HELiOS Database Creator or via your SQL server application.
Please contact the ISD hotline if you have any questions or need support for your individual system archi-
tecture.

2. The log file of the update: If any conflicts occur during the update, they are traced in the log file
HeliosDbUpdate.txt (in the system path%appdata%\ISD Software and Systems\HeliosDbUpdate\). Have
this file ready if you contact the ISD hotline for troubleshooting and successful updates.

New Mask Editor in HELiOS 2020

Due to the complete revision of the Mask Editor in HELiOS 2020, the previous mask format has been changed
from .MSK to .XML. In addition, mask files are now managed outside the installation directory, resulting in
some changes in the system architecture that Administrators must consider:

n The masks of older versions (before V 2500.0) that were previously stored in the SYS directory of the install-
ation are automatically converted to the new XML format in case of an update installation and stored at
%Programdata%.

n The new masks at %Programdata% should not be overwritten under any circumstances, as these rep-
resent the "delivery status", which will be updated by later update installations. If masks are edited and
changed with the Mask Editor, youmust store and call them at %Appdata%.
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Updating the HELiOS-Inventor interface

For an update of the Inventor interface from an older HELiOS version to HELiOS 2020 (Version 2500) or higher
(and the corresponding update of the database schema) the following changes have to be considered:

1. The structure identifiers for Inventor parts must be updated.

2. The standard part and semi-finished product identifiers are changed to a document-based (instead of art-
icle-based) management.

An update installation can only be carried out after an appropriate preparation of the migration.

In case of an update, please contact the Consulting team of the ISD Group. New installations of HELiOS 2020
and the associated database are not affected.

Updating the HELiOS-SOLIDWORKS interface

For an update of the SOLIDWORKS interface from an older HELiOS version to HELiOS 2020 (Version 2500) or
higher (and the corresponding update of the database schema) the following changes have to be considered:

Since a migration of the configuration IDs is performed during the update, an update installation can only be
performed after the migration has been prepared accordingly. In the event of an update, contact the Con-
sulting team of the ISD Group. New installations of HELiOS 2020 and the associated database are not
affected.

Important update notes for attribute mapping in title blocks

Until HELiOS 2019, attribute mapping at SOLIDWORKS was done by the following files:

n heliossw_titleblock.dat (attributes for the title block),

n helios_cs_global_config.dat (attribute mapping/presetting in both directions),

n sw_comp_name.dat (display in the model tree in CAD).

As of HELiOS 2020 (Version 2500.0), the mapping must be set up again manually. No migration tools exist.

Up to HELiOS 2019, the attribute for the title block in AutoCAD was created using the following files:

n heliossac_titleblock.dat,

n helacblock.xml

As of HELiOS 2020 (version 2500.0), the mapping must also be set upmanually here.

In case of an update, please contact the Consulting team of the ISD Group.
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Important notes for administrators during a HELiOS update installation working with the HELiOS integ-
ration for Inventor, AutoCAD and SOLIDWORKS!

When updating the database to HELiOS 2019 Service Pack 2 or higher, the old workspace is checked for doc-
uments in progress. These are documents with the pen symbol in the respective (old) workspace dialog, or
entries of locked documents in the Workspace Manager from HELiOS Desktop (on the right hand side).

Should the check find relevant documents, the following message appears:

The update of the database cannot be performed because there are still locked documents in old local work
areas which will not be supported in the future. After this update, only work areas with new administration are
supported and automatic migration is not possible. More information can be found here.

Plant Engineering and Pipeline planning

If you have used the HiCAD modules Plant Engineering or Pipeline Planning with a HiCAD version older than
Version 2016, it is mandatory that you read the information on update procedures given in the Online Help and
also in the PDF document "Plant Engineering/Pipeline Planning – Notes on Updates".

Material Manager

The Material Manager (materialmanager.exe) that enables a taking over of materials from Catalogue Editor to
HELiOS needs to have the same database schema as HELiOS. Therefore the Material Manager will also be
updated.
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Licensing in Case of Updates
Before updating HiCAD/HELiOS 2019 or 2018 to HiCAD/HELiOS 2020 you need to deactivate all licenses (Server
licenses or local licenses). The procedures for Server Licenses and Local Licenses are different.

Updating the Server License
For a Server license the License Server software and the License Management tools may require an update. Fur-
thermore, you need to deactivate the licenses for Versions 2019 or 2018 first, and then activate those for Version
2020.

You can start with the installation of HiCAD/HELiOS before or after activation of the new licenses; a starting of the
software is, however, only possible after activation of the new licenses.

The current Version of the License Server, Sentinel RMS License Manager 8.6.2, can be found on the installation
medium of HiCAD/HELiOS 2020. If you have an older version, you need to uninstall this version with the help of the
Windows Control Panel. First, uninstall the Sentinel RMS License Manager there and (if there are any) the
AdminToolsServer.

You can then install the new version of the License Server from the installation medium. Start the installation wizard
and click on the Standard Edition button. In the selection mask of the installation wizard, click on the License
Server button.

Before you can use the new licenses of HiCAD/HELiOS 2020 you need to deactivate the old licenses for Version
2019 or 2018 with the help of the License Manager. This tool is located in the Windows Start menu at All programs
> ISD Software und Systeme > Administration.

After starting the ISD License Manager the License Activator tab will be active. Normally, the EID (Entitlement ID)
field is still filled in and the fields E-mail and Password are still empty. The activated modules of Version 2019/2018
are highlighted (blue). Click on the Deactivate button to revoke the activation of these modules.
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To activate the new licenses you require the ISD License Manager. After installing HiCAD/HELiOS 2020 this tool
will be available to you in the Start menu of Windows at ISD Software und Systeme > Administration.

Another prerequisite for the activation of the new licenses is their requesting via the new Update form (isd-
group.com > Support & Schulung > ISD Wiki > Download) and the subsequent provision of the licenses by the ISD. .

Start the ISD License Manager, which you can find in the Start menu of Windows at ISD Software und Systeme >
Administration(C:\Program Files (x86)\ISD Software und Systeme\AdminToolsServer\exe).

On the License Activator tab, enter the Entitlement ID, your E-mail address and your Password and click Login.
After connecting to the ISD License Server , all your purchased licenses will be shown. Use the checkboxes to
select the modules that you wish to activate and confirm your selection with a click on the Activate button.

After successful activation you can start HiCAD/HELiOS.

Updating Local Licenses
Before installing HiCAD/HELiOS 2020 you need to deactivate the local licenses for HiCAD 2019 or 2018 on your
workstation. After installing HiCAD/HELiOS 2020 you need to activate the new licenses.

To deactivate the old licenses you use the ISD License Manager which is located in the Windows start menu at ISD
Software und Systeme > Administration (C:\Program Files (x86)\ISD Soft- ware und Systeme\Ad-
minToolsServer\exe).

On the License Activator tab, click on the Deactivate button to revoke the activation of the modules, i.e. to deac-
tivate them. After successful deactivation, a corresponding message will be displayed.

To activate the new licenses you require the ISD License Manager 4.0. After installing HiCAD/HELiOS 2020 this
tool will be available to you in the Start menu of Windows at ISD Software und Systeme > Administration.

Another prerequisite for the activation of the new licenses is their requesting via the new Update form (isd-
group.com > Support & Schulung > ISD Wiki > Download) and the subsequent provision of the licenses by the ISD.
After installing HiCAD/HELiOS, start the ISD License Manager, which you can find in the Start menu of Windows at
ISD Software und Systeme > Administration (C:\Program Files (x86)\ISD Software und Systeme\Ad-
minToolsServer\exe).

On the License Activator tab, enter the Entitlement ID, your E-mail address (the address to which the E-mails of
the Activation@isdgroup.de were sent) and your Password and click Login.

After connecting to the ISD License Server , all your purchased licenses will be shown. Use the checkboxes to
select the modules that you wish to activate and confirm your selection with a click on the Activate button. The
selected modules will then be activated on your workstation. You can deactivate them again at any time to enable
their use on a different workstation.

After successful activation you can start HiCAD/HELiOS.
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Carrying Out the Installation
The installation of HiCAD/HELiOS can be carried out by a technician of the ISD or by the customer.

In this context, please note the following recommendations by the ISD:

n HiCAD without HELiOS

l Update of version 2019 or 2018 to version 2020: Can be carried out by experienced users with sufficient
background knowledge.

l Update of version 2017 (or older) to version 2020: An update is not possible. The update installation from
version 2008 (or older) additionally included a data conversion from ANSI to UNICODE format. Please con-
tact our Consulting team.

n HiCAD with HELiOS

l Update of version 2019 or 2018 to version 2020: An installation by the ISD is recommended.

l Update of version 2017 (or older) to version 2020: An update is not possible. The update installation from
version 2008 (or older) additionally included a data conversion from ANSI to UNICODE format. Please con-
tact our Consulting team.

n 3rd party CAD with HELiOS

l Update of version 2019 or 2018 to 2020: An installation by the ISD is recommended.
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Data Compatibility of HiCAD/HELiOS
No changes are made to the HiCAD data format and the HELiOS standard database within major releases. This
means that all patches and service packs of a version (e.g. 2500.x, 250X.x) will be using the same data format, and
no HELiOS update will be required.

When updating from older HiCAD versions to HiCAD 2020(Version 250X), please note the information given below.
Updates to version 2020 are only possible from version 2019 (Version 240X) or 2018 (Version 230X).

Update from Version HELiOS Update HiCAD data format changed

HiCAD 2019 Version 240X

HiCAD 2018 Version 230X

Please note:

n If a HELiOS update is necessary, older HiCAD, respectively HELiOS versions have no access to the data-
base any more. All workplaces need to be converted at the same time.

n If the HiCAD data format has been changed, drawings and parts cannot be loaded with the older version if
they were saved with the new version.
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Update of HiCAD
The ISD recommends performing an Update Installation when switching from HiCAD 2019 or 2018 to HiCAD 2020
or for the installing of Service Packs and Patches.

Important update notes - please read carefully!

When you run the Computer Parameter Configurator (HiCAD exe\ParKonfigComp.exe) tool – either during
the installation/update (Extended Settings > User Configuration tab) or later – the following message will be
displayed.

After confirming with OK, various system files in the HiCAD sys and szenen directory will be replaced with the
files supplied in the HiCAD templates directory which have been designed especially for a working with the
selected module and the activated checkboxes (e.g. …DSTV or Management + BIM). These files include, for
example

n HiCAD masks for the part attributes (*.HDX),

n HELiOSmasks for projects, documents and articles (*.XML, *.MSK),

n Various configuration files (*.HDB) and

n Template files for annotations (*.FTD).

You should therefore always make backups of all files that you have customized before using the ParKon-
figComp.exe tool! If you have any questions, please contact your nearest ISD branch office.

Cancel aborts the operation without any changes to the configuration.

Backups Before Performing the HiCAD Update Installation
Bevor Sie die Update-Installation von HiCAD starten, sollten Sie ein Backup folgender Dateien erstellen:

n Catalogues

n HiCAD.cfgdb (Configuration Database)

n HELiOS Database (only required when you actually work with a HELiOS Database)

These components will be automatically updated during the installation. Nevertheless is a backup of these com-
ponents recommended, e.g. for cases in which an unexpected interruption of the update occurs.

Please create an archive folder for the storage of these backups.

Backup of catalogues
Find the folder where the catalogues of the old version are located.
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n In case of a local installation this is usually the KATALOGE folder in the directory of your HiCAD installation.

n In case of a network installation the catalogues are normally located in a shared network folder, which is indic-
ated in the Windows Registry at HKEY_LOCAL_MACHINE\SOFTWARE\ISD Software und
Systeme\HiCAD\240X.X (or 230X.X) in the CatDir key.

In the Windows Explorer, right-click the folder that contains the catalogues. Select Send to > Compressed
(zipped) folder. Important: Please choose a descriptive name for the zipped folder enabling an easy recognition of
the catalogues, e.g. HiCAD_2019_CATALOGUES.ZIP

After its creation, move the file to the archive folder.

Backup of Configuration Database HiCAD.cfgdb
Before installing the new HiCAD version, copy the old file HiCAD.cfgdb to the archive folder.

In the Windows Registry at HKEY_LOCAL_MACHINE\ SOFTWARE\ISD Software und Systeme\HiCAD\240X.X (or
230X.X) in the CfgdbPath key you can see where the file HiCAD.cfgdb is located.

Backup of HELiOS Database
Open the SQL Server Management Studio. Select Start > All Programs > Microsoft SQL Server 240X (or 230X.X)
> SQL Server Management Studio. Click Connect.

On the left side, right-click bauteil… in the list. Then, select Tasks > Back Up. Make sure that the backup will be
stored in the archive folder. You can then compress the backup file (.bak) to a ZIP file.

Update Installation of HiCAD
You can conveniently download the current HiCAD version in the Download Area in the ISD Wiki. On the cor-
responding installation medium you will find, besides the HiCAD installation, further utilities and the HELiOS install-
ation. Please note that the HELiOS installation is the last available HELiOS patch containing the same database
subversion as the HELiOS version that was originally released with the corresponding Major Release. The advant-
age of this is that you will not need to update the database as well thanks to the simultaneous installation of
HELiOS.

Start Windows to begin with the Update Installation. If Windows has already been opened, close all other applic-
ations and start the installation wizard.

In the installation wizard, click the Standard Edition button, which opens a mask with various selection options for
software components.
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Click on the HiCAD and HELiOS button.

Please read this information carefully.

If the installation program finds an already installed HiCAD Version, this will be indicated in a corresponding dia-
logue window.
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Activate the Update Installation option and click Next.

You can help us increase the user-friendliness of our products even further. To participate or terminate your par-
ticipation, please activate the corresponding checkbox.

You can terminate your participation at any time by choosing Help > Customer Feedback, and selecting the cor-
responding checkbox.
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You can now start with the installation or modify the Extended Settings, e.g. for the user configuration, the cata-
logues, or HiCAD with HELiOS

At Configuration Database, customer-specific settings for various features such as dimensioning, annotations,
workshop drawing creation or fitting of vertical ladders are stored. Whenmaking an update, customer-specific set-
tings can be applied. In addition, values that have not been modified by the user will automatically obtain the
updated pre-settings.
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At Parameter configuration, you can modify the previously set Standard templates if desired. If you choose Own
templates, you can select a CSV file. In a CSV file it is, amongst other things, specified which files (e.g. HiCAD part
masks or template masks for annotations) are to be copied to the sys directory. When performing an Update, vari-
ous system files in the HiCAD sys directory will be replaced with the files supplied in the HiCAD templates directory
which have been designed especially for a working with the selected module and the activated checkboxes (e.g.
…DSTV or Management + BIM). The standard CSV files are located in the templates directory of the HiCAD install-
ation. CSV files are configuration templates that you can create and edit with Microsoft Excel (please see Online
Help).

Parameter configuration: No templates is activated by default. You can also change this setting subsequently, via
the programs ..exe/ParKonfigComp.exe (for the workstation) and ..exe/ParKonfigUser.exe (for the User).

The execution of the CatalogueMaker serves the purpose of specifying which standard series are to appear in the
standard part catalogues (currently standard series are available for DIN, ISO, EN, ANSI and JIS); the selection of
standards in the CatalogueMaker only influences the display of standard parts, but not their availability; the avail-
ability is still controlled via license selection in the ISD License Manager.

In case of updates, the existing configuration will be applied, and the CatalogueMaker will not be started auto-
matically. If you want to add standards to the catalogues, the program can be called via Start > All Programs > ISD
Software und Systeme GmbH > Administration.
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In case of a new installation of HELiOS you can specify an arbitrary name for the system data source. In case of an
update, the existing data source will be offered. User and Password will be identical with the ODBC login.

If you use a Vault Server, activate the Vault Server checkbox. Enter the name of the Server in the Address input
field, and the Server Port of the Vault Server in the Port input field. You already entered both during the installation
of the Vault Server.

If you have not installed the Vault Server yet, you can do this now: Choose HELiOS Options > Database > General >

Vault Server and specify the connection. For activation youmust then restart the HELiOS Desktop.

During an update installation it will be checked whether the existing HELiOS version is newer than the one on the
DVD. If this is the case, the HiCAD installation will only update the non-HELiOS files. The HELiOS files are those
that would be supplied by a standalone installation of the HELiOS Desktop, minus the hicadcommons contained
therein.

If you want to process your print jobs via the ISD Plot Management, you need to install one PrintClient on each
workstation. Activate Use Spooler . In the Server field, enter the network name of the computer on which the
Spooler is installed. The Spooler collects the print jobs and processes them, taking your settings into account.

Individual settings of HELiOS can be distributed to other users or workstations. To do this, create a ZIP file in
HELiOS at View > Settings > Export.

During installation, if the option Use central directory for configuration data (across computers) is activated, you
can save the configurations of the HELiOS Desktop to a central computer and select and import them at Con-
figuration file.
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The availability of interfaces with HELiOS depends on the programs that are installed on your computer. With the
exception of the HELiOS interface, you can only use 32Bit versions with HELiOS 32Bit, and 64Bit versions only with
HELiOS 64Bit. For MS Office it is generally possible to use a 32Bit Office with HELiOS (64Bit). However, for old
BOMs an additional, special ODBC connection will be required. In such cases, please contact our Consulting team.

Multiple selections are also possible. The HELiOS functions will be integrated in the programs that are linked to
HELiOS.

Please note:

n Integration of shared networks
If a directory is accessed by more than one computer, in the filegrup.dat under C: (for the Scenes directory)
should not be listed a local path or the network connection letter, but the entire UNC path according to the
pattern C:\\servername\ShareName\Directory. The filegrup.dat can be found in the HiCAD/HELiOS install-
ation in the HiCAD exe directory and in case of an EPLAN interface as well under HELiOS EPLAN Syn-
cService\exe. In the HELiOS Standalone installation the filegrup.dat can be found in the HELiOS exe
directory.
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If you have installed LogiKal on your computer, you can enter the installation directory here.

Please note:

In HiCAD, at Settings > Further directories you can set the paths for the database of the Configuration
Editor, the Catalogue Editor and LogiKal. These paths are located in the Windows Registry at HKEY_LOCAL_
MACHINE\SOFTWARE\ISD Software und Systeme\HiCAD\nnnn.n.

nnnn.n is the HiCAD version number, e.g. 2500.0.

Installation Notes 117 / 190

HiCAD and HELiOS



The Activate license administration tools optionmust be activated for the management of server licenses.

Please note:

During installing of HiCAD, a ISD License Manager that may exist will be uninstalled. By checkmarking the
Activate license administration tools optionoption you can reinstall the current standard ISD License Manager
during the installation.

If you checkmark the Activate ISD Update Service option, a Hotfix will be searched on the ISD Web Server when
you start HiCAD. You can also activate this option subsequently via the Windows Control Panel: There, choose Pro-
grams and Features, right-click on HiCAD and choose Change.

Click Save to save the Extended Settings to an .ini file. If you place the .ini file in the installation directory when
installing server licenses, the settings will be applied.

As soon as you exit the Extended Settings dialogue with OK, the installation will be started.
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Click Continue anyway to start the installation.

Towards the end of the installation you can specify the procedure for the updating of the catalogue files. If you
select Cancel, the catalogues will not be updated.

Please remember that HiCAD will check the version of the utilized version upon HiCAD start. If the catalogue dir-
ectories are old there is a risk that HiCAD will search for catalogue entries which do not yet exist in the old cata-
logues. One example of this is the Textures that were integrated in the catalogue some time ago. If these are
missing in the catalogue, you will have no access to these Textures in HiCAD. Use the CatalogueUpdate.exe pro-
gram in the HiCAD EXE directory to update the catalogues

Specify the desired settings and click Update.

After successful updating, the update information for the replaced files will be shown in a dialogue window. The old
files will be preserved and renamed, e.g. 0.mac > 0.mac.2500.
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Click Save to save this list to a directory of your choice. Click OK to continue with the installation.
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Click Finish to complete your HiCAD installation. .

If you have already activated the new Server License before the installation, you can start HiCAD now (Stand-
ard Konfiguration).

If you have a local license you need to activate it first before you can start HiCAD.
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ISD Update Service
The automatic search for and installation of HiCAD/HELiOSupdates (Hotfixes). For this you require the program
ISDUpdateSvc.exe, that you can either activate during installation of HiCAD or install via the Windows Control
Panel afterwards.

Installing the ISD Update Service
You can activate the automatic search for and installation of HiCAD/HELiOS updates (Hotfixes), either during the
installation of HiCAD/HELiOS or, later, via the Windows Control Panel.

During installation you can go to Extended settings > General and activate the Activate ISD Update Service
option to activate the automatic search for Updates on the ISD Server. You can also activate or deactivate this
option afterwards via the Windows Control Panel.
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In the Windows Control Panel, choose Programs and Features, right-click on HiCAD/ and choose Change.
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Checkmark Activate the ISD Update Service and click Next. After all options have been queried, click Change.

After successful installation, the program ISDUpdateSvc.exe will be located by default in directory C:\Program
Files\ISD Software und Systeme\ISD Update Service

Using the ISD Update Service
If you have installed the ISD Update Service, the following message appears at the bottom right of your screen
whenever a Hotfix is available:

Click on the message or double-click on the icon at the bottom right to start the ISDUpdateSvc.exe program.
You can also directly double click on the ISDUpdateSvc.exe file to start the program. Confirm the query in the Win-
dows User Account Control dialogue window.
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If an update is available, click the Download button to download it from the ISD Server to your computer. If an
update should not be displayed anymore, activate the Hide... checkbox.

Installation Notes 125 / 190

HiCAD and HELiOS



126 / 190 Installation Notes

Update



After downloading of the Hotfix, click Install.

Confirm the Windows Security Warning with Install.

Follow the instructions on the screen to install the update.

The HiCAD Info window displays the current HiCAD version number (including build number) as well as the numbers

of any installed hotfixes. To show the info window, click on Help Topics and Information and choose
HiCAD.
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ISD Update Service: Settings

If you have installed the ISD Update Service, you can, after calling the program (with the icon at the bottom right
on the Windows Taskbar, or by double-clicking on the file ISDUpdateSvc.exe), configure the search and the install-
ation with the Settings button.
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Via the Settings button you can specify the download directory for Updates and a time interval for the search for
updates.

You can use the icon to start the search for updates manually.
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Updating the HELiOS Database (Database Schema)
Improvements of the HELiOS functionality require a regular updating of the database; if the database version is no
longer up to date, HELiOS displays the following message (version numbers may vary) when it is started:

To update the database schema, use the program HeliosDbUpdate.exe.

HELiOS Data base schema

As existing datasets with non-compliant conditions may cause conflicts during the central update process of
the HELiOS delivery database, you should consider the following:

1. Do a database backup: You shouldmake sure that a backup of your HELiOS database has been created
before the update. This can be done with the HELiOS Database Creator or via your SQL server application.
Please contact the ISD hotline if you have any questions or need support for your individual system archi-
tecture.

2. The log file of the update: If any conflicts occur during the update, they are traced in the log file
HeliosDbUpdate.txt (in the system path%appdata%\ISD Software and Systems\HeliosDbUpdate\). Have
this file ready if you contact the ISD hotline for troubleshooting and successful updates.

Please note:

n It is mandatory to make a database backup before the update, as the update can normally only be reverted
by importing the backup.

n After an update, access is only possible with the appropriate HELiOS version. A mixed operation with
HELiOS versions requiring an older database schema is not possible.

n The update must be performed once and applies to all HELiOS installations.

n The responsible administrator should always be informed prior to the update, in order to enable a coordin-
ated conversion.
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n In some cases, a window with the message "The designations of the database attributes must be updated."
will be displayed during the update process. In such cases, the language-dependent standard designations
for attributes will be updated. This applies only to standard designations of attributes which have not been
changed or created by the user, i.e. only for attributes according to the default settings. This means that
designations that were assigned via Attribute Editor by the user will remain unchanged in the process.

The update can be performed from any HELiOS workstation with a database connection.

The HeliosDbUpdate.exe program is used for this purpose. It can be started via the Windows Explorer, or similar
programs, from the exe directory of the HELiOS installation.

The following mask (software and database versionmay vary) will be displayed after starting the program:

Click the Update database… button to start the update.

The following message (version numbers may vary) will be displayed after clicking the button.

If you confirm this message with OK, another confirmation prompt is displayed.
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Confirm with Yes to perform the update. After a successful update, the following message will be displayed.

A further check can be carried out by clicking the Re-determine button in the main window of the program, after
confirming this message with OK.

After a successful update, software version and database version should be identical.

Please note:

If you use HiCAD and HELiOS together it may occur after an update of HiCAD that according to the error mes-
sage for verification of your database version the number of the required sub-version is lower than that of the
current one, which is, according to the message, not supported.

In this case, please contact our Hotline:

Tel: 02 31 / 97 93 - 166

Fax: 02 31 / 97 93 - 101

E-Mail: support@isdgroup.com
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Manual Registration of Multi-CAD Add-ins
If you use both HiCAD and HELiOS on your system in mixed operation it is not possible (as opposed to the stan-
dalone version of the HELiOS Desktop) to establish an interface between HELiOS and further CAD or CAE software
via an update or modification installation.

To do so you can use the HeliosCouplings.exe tool (in the /exe/ directory of the HiCAD installation).

It can be used to activate interfaces with AutoCAD, Inventor, SOLIDWORKS or EPLAN.

Activate the checkbox of the required software and confirm with OK. The interface will then be activated.

The respective software has to be installed in the system.
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New Mask Editor for HELiOS
The Mask Editor (as of HELiOS 2020) has been completely revised. Besides a modern ribbon design, which also sup-
ports operation at high resolutions, the basis for a further expansion of the masks and the editor has been laid.

The revision of the mask editor has also led to a conversion of the mask format to XML. Mask files are now man-
aged outside the installation directory.

New mask format and central mask configuration
In HELiOS 2020, the previous mask format has been changed from .msk to .xml, parallel to the revision of the mask
editor. In addition, mask files are now managed outside the installation directory, resulting in some changes in the
system architecture that administrators should urgently consider:

The masks of older versions that were previously stored in the \sys\ directory of the installation are automatically
converted to the new XML format by an update installation of an older HELiOS version to HELiOS 2020 (V 2500.0) or
higher and stored at%Programdata%.

At %Programdata%, the masks are stored in a version-specific path, i.e. for HELiOS 2020 this path could look like
this: "C:\ProgramData\ISD Software und Systeme\HELiOS 2020\GUI\Masks". In a later version, the version identifier
in the path will be correspondingly higher.

This conversion or directory is not dependent on whether the local or central directory was selected for the interface
configuration (see below).

The old configuration file can then be found in a Backup directory that was created below the installation folder.
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The new masks at %Programdata% should not be overwritten in any case, because these are the "delivery status",
which may be updated by later update installations. If masks are edited and changed with the mask editor, they are
stored at %Appdata% and are called up by HELiOS when working in corresponding masks from this directory.

Important:

This means: If masks are to be distributed uniformly to different workstations, they must be saved under%Ap-
pdata% and not (!) under%Programdata%.

Mask Converter
During the update installation - starting from an installation earlier than HELiOS 2020 - the tool MskToXm-
lUpdate.exe is placed in the exe directory of the HELiOS installation. This tool is used by the installation program
when updating to HELiOS 2020 for automatically converting masks in the old MSK mask format to the new XML
mask format. The images contained in the masks are also copied together with the masks.

If necessary, this tool can also be used to convert old mask files to the new XML mask format at a later date. To do
this, the tool must be started as administrator from the Windows command line as follows

MskToXmlUpdate –BACKUPPATH=path name –MSKPATH=path name

A pathmust be specified for both the BACKUPPATH andMSKPATHparameters.

BACKUPPATH

Here the directory must be specified to which the "old" MSK/BMP files are to be moved after conversion.

After the conversion, a conversion log with the name _MskToXmlResult.txt is saved in this directory.

MSKPATH

Here the directory has to be entered containing the files to be converted.

Example:

MskToXmlUpdate –BACKUPPATH=C:\helios\sys\backup_msk -MSKPATH=C:\helios\sys\

The files are automatically converted into the file %PROGRAMDATA% of HELiOS, for instance […]\Pro-
gramData\ISD Software und Systeme\HELiOS 2020\GUI\Masks.
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New File Format for 2-D Files in HiCAD
Similar to the KRA files in 3-D there are now 2-D figure archives with the filename extension .FGA. This contain the
previous 2-D data (.FIG), the DB attributes (.FIG.DBA2) as well as the attribute container data (.FIG.ATC) and
replaces the former 2-D files. Moreover, the new FGA format allows the displaying of 2-D files in HiCAD Viewer and
also contains the 2-D HCM files.

Discontinuation of the old figure format (FIG)

Since HiCAD 2017 we have been supporting FGA as figure format (before FIG). Starting with HELiOS 2021 (Ver-
sion 2600.0), we assume that the figures stored in HELiOS have been converted to the new format, or convert
the still existing figures automatically as part of the database sub-version update to Version 2600.0.

Please use only this new .FGA format for conversion of existing 2-D .FIG files! For this purpose, use the new
Converter_FIG_To_FGA.exe tool in the HiCAD\exe directory.

When updating from HiCAD 2016 or older, all standardly supplied 2-D parts (e.g. drawing frames) in the dif-
ferent installation directories will be converted from FIG to FGA by default during the installation. The data in
the original state will be saved in a folder (resp. a ZIP archive) in the scene and catalogue directory. The con-
verted files will be documented in a LOG file.

When creating an interface between HiCAD and HELiOS, you will be prompted to update the databases after a
new installation or an update installation. The search for and management of 2-D parts will only be possible
after conversion of the database and the existing .FIG files with the above mentioned tool.

Conversion of 2-D Data to the FGA Format
If you are managing your HiCAD files with HELiOS a message will appear after an update or a new installation from
HiCAD 2017 when you start HiCAD as Administrator:

By clicking Yes you convert the files to the database. This means that the 2-D part name contained in the data will
be changed from *FIG to *.FGA. Moreover, the database now only searches for FGA files. Therefore, you also have
to convert the 2-D parts into FGA files by using the Converter_FIG_To_FGA.exe program.

If you have installed HiCAD 2017 or higher for testing purposes, you will have to click No when the message
appears. Older HiCAD versions (before HiCAD 2017) cannot load FGA files. A database conversion cannot be
undone.

After the conversion the following message appears
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Now start the Converter_FIG_To_FGA.exe program to convert the 2-D parts.
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Folder to
scan

Enter the path of the folder that should be converted. Via this symbol you can select the
folder in the Windows Explorer.

The folder will only be evaluated if there is an activated checkbox behind Folder to scan.

Filegrup.dat In order to search the directories in the Filegrup.dat for FIG files the checkbox behind File-
grup.dat has to be activated.

All directories from the Filegrup.dat that are activated will be considered when searching
for FIG files.

Create
backup (zip)

If you have activated Create backup a ZIP file with all selected FIG files will be created.

Overwrite
existing FGA

If you have activated the Overwrite existing FGA option, existing FGA files will be overwritten if
the names are identical with the converted files.

Folder
backup and
log

Enter the path for the backup and log file here.

Scan for
*.FIG

By pressing the Scan for *.FIG button you start the search for FIG files in the selected folders.

Convert FIG -
> FGA

Via Convert FIG -> FGA you start the conversion. In the process all *.FIG, *.FIG.DBA2 and
*.FIG.ATC will be deleted.

After the conversion the number of converted files will be displayed. Furthermore, the number of defective con-
verted files will be shown. Further information regarding the error can be found in the LOG file.

Installing the FIG-FGA Converter
Start Windows to install the FIG-FGA Converter. If Windows has already been opened, close all other applications
and start the installation wizard.

In the installation wizard, click the Standard Edition button, which opens a mask with various selection options for
software components.

Leave the selection mask of the installation wizard open, so that you can select the desired components one after
the other.
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Click on the FIG-FGA Converter button.
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Enter the installation directory for the software.

Click Install.
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After successful installation the Converter_FIG_To_FGA.exe can be found in the program folder.
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CatalogueMaker
The CatalogueMaker will be called automatically by the installation program when you carry out a new installation.

It specifies which standard series is to be shown in the standard part catalogues (at the moment standard series are
available for DIN, ISO, EN, ANSI and JIS). The selection of the standards in the CatalogueMaker influences the dis-
play of the standard parts only, not their availability. This will still be controlled by the license selection in the con-
figurationmenu.

The existing configuration will be taken over automatically in case of an update; the CatalogueMaker will not be
started automatically. If you want to add standards to the catalogues, the program can be called in the ISD program
group in the start menu via “Administration".

142 / 190 Installation Notes

Update



Licensing
n General Notes on Licensing

l ...for Local Licenses

l ...for Network Licenses

l ...for Commuter Licenses

n Installing the License Server

n Licensing via Licensing ID (License Activator)

l AutoRequest Licenses

l Activate Licenses

l Deactivate Licenses

l Trial Licenses

l Reconstruction of Licenses

l Notes on the Use of Modbile Computers (Laptops)

l Floating Lizenzen

n Commuter Licenses

l Checking Out Commuter Licenses, with Network Connection

l Checking Out Commuter Licenses, without Network Connection

n License Configuration

n Server Monitor

n Theft of a Workstation
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General Notes on Licensing
HiCAD/HELiOS can be activated via 3 types of licenses:

n Standalone Licenses (Local Licenses)

n Network Licenses

n Commuter Licenses

Please note:

n A static IP address is required for a correct operation of the License Server.

n If you activated a license while the WLAN card is switched on, this license will only be valid and visible
when the WLAN card is switched on.

n In the HiCAD/HELiOS directory DOCU you can find an Online Help for the Licence Manager. You start the
Help by calling the LICENSEMANAGER.HTML file in the folder Docu\tools\Licensemanager.

n In the ISD Wiki at Product Know-how > Whitepaper you can find the PDF document Use case: Checkout
Licenses.

General Information on Local (Workstation-specific) Licenses
If you choose local licensing, the activation will be directly locked to the hardware of the workstation on which your
HiCAD and HELiOS Desktop program is installed.

The ISD will send you an E-mail containing the Entitlement ID for local licenses (standalone). This ID will be required
for the activation and deactivation of the licenses and software modules. Please keep the Entitlement ID! Without
this ID you cannot activate or deactivate any licenses! In case of a defect, no reconstruction of licenses will be pos-
sible without the Entitlement ID! After installing HiCAD/HELiOS , you activate the licenses by means of the License
Activator in the ISD License Manager.

General Information on (Server-controlled) Network Licenses
If you choose network (server-controlled) licensing, the license will be directly locked to the hardware of the server
that centrally manages the HiCAD/HELiOS licenses. These licenses can be used on any workstation in your net-
work that is connected to this server.

The ISD will send you an E-mail containing the Entitlement ID. If you have several network servers, e.g. at several
locations, you will receive one Entitlement ID for each network server. This ID will be required for the activation and
deactivation of the licenses and software modules. Please keep the Entitlement ID! Without this ID you cannot activ-
ate or deactivate any licenses! In case of a defect, no reconstruction of licenses will be possible without the Enti-
tlement ID! You activate/deactivate the network licenses by means of the License Activator in the ISD License
Manager.

To be able to use network licenses, a License Server needs to be installed on a computer without HiCAD/HELiOS.

The license server enforces and manages licensing in multi-user environment. It keeps track of all the licenses and
handles requests from network users who want to run a HiCAD/HELiOS application, granting authorization to the
requesters, or denying requests if all licenses are in use.

The license server must not be installed on the same computer on which an ISD software product (HiCAD/HELiOS)
is installed, as both product share system data concerning the licensing information. Formerly, such parallel install-
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ations of license servers and ISD products were performed in cases where a customer occasionally wanted to trans-
fer the license to another computer (Remote Commuter License).

Important:

Installations of license servers and ISD products on the same computer are no longer covered by the warranty.
The ISD group advises you strongly not to perform such installations.

A static IP address is required for correct operation of the license server.

General Information on Commuter Licenses
Individual licenses can be checked out from the server and locked to a workstation within or outside the network
(so-called “commuter licenses”). This enables you to continue working at a different location, without being con-
nected to the license server (unless your HiCAD/HELiOS installation requires a connection to a database server).
For this purpose you define a specific period during which you want the license to be available on a selected work-
station. For this period, this license will be blocked on the license server. After expiry of this period, the license will
be made available on the license server again. It is also possible to manually return this license to the server before
expiry of the defined period, if the workstation is connected to the server. Licenses for one workstation can be
checked out for at least one day, with the counting beginning at 1:00 AM on the day following the checkout date.

If you want to replace/exchange your license server, you need to deactivate all licenses first.

Practical Examples of Network Licensing
n Let us assume that three licenses have been activated on your server. Monday morning (11.00 am) you sud-

denly need to see a customer for design tasks, and you know that you will still be on-site at the customer’s facil-
ity on Tuesday. You therefore check out a license for 24 hours on 11.00 am. This means that you can use this
license until Tuesday night, 11.59 pm, from your mobile workplace. After expiration of this period, the license is
automatically made available again on the server. If youmanage to finish your work on Tuesday at midday, you
can go back to your office and return the license to the server somewhat earlier.

n Similar situation as the one described above, with the difference that you are not in your office onMonday,
11.00 am. In such cases you can generate a hardware ID, enabling your colleagues in the office to check out a
license for you. This license is sent to you by E-mail and can then be activated. In contrast to the previous

Installation Notes 145 / 190

HiCAD and HELiOS



example, this license is exclusively available to you for a fixed period of time and cannot be returned to the
server before expiration of this period.
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Installing the License Server
If you want tp perform a HiCAD/HELiOS update to Version 2020 and use a license server (i.e. work with network
licenses), you require Version 8.6.2 of the License Server. If you have installed an older version, you need to unin-
stall it before re-installing the License Server.

To install the License Server, start Windows. If Windows has already been opened, close all other applications and
start the installation wizard.

Click the Standard Edition button, which opens a mask with various selection options for software components.

Leave the selectionmask open, open, so that you can select the desired components one after the other.

Click on the License Server button.
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After successful installation you will find the Server (Sentinel RMS License Manager) under Services. From here you
can also start and end the License Server.

Important:

To ensure that the HiCAD/HELiOS Client will find the correct License Server, an environment variable
LSFORCEHOST should be set on each Client using network licenses. The value HOSTNAME, respectively the
IP address of the License Server is assigned to the variable.
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Licensing via Entitlement ID (License Activator)
The ISD License Manager significantly facilitates the communication between the customer and the ISD during
licensing.

Important:

For the activation of HiCAD/HELiOS 2020 the ISD License Manager 4.0 will be required.

AutoRequest Licenses
When acquiring a HiCAD/HELiOS license, you will obtain one Entitlement ID for local licenses (Standalone) and
another one for network licenses (Network). If you have several network servers, e.g. at different locations, you will
obtain one Entitlement ID for each network server. These numbers will be required for the activation and deac-
tivation of the licenses and the software modules.

Important:

Please keep the Entitlement ID! Without this number you cannot activate or deactivate licenses. In case of a
system crash a reconstruction of the licenses cannot take place without the Entitlement ID.
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After installing HiCAD/HELiOS you can find the program in the Windows Start menu at ISD Software und Systeme
> Administration. Please note that for the execution of some functions, administrator rights are required.

The range of functions of the ISD License Manager depends on the activation of the License Administration Tools
option. The information about this setting is entered in the Registry and can also be changed there subsequently if
desired (please contact the Hotline).

Important:

To activate/deactivate Network Licenses, always start the ISD License Manager via the Windows Start menu:
Select Start > All programs > ISD Software und Systeme GmbH > Administration. To avoid errors when activ-
ating/deactivating licenses, perform an update of the new ISD License Manager and/or the License Admin-
istration Tools beforehand.

Activate the License Activator tab and enter the Entitlement ID, your E-mail address and your Password. New cus-
tomers obtain their password from the ISD Hotline. With this password you can also access the Download Area.

After entering the data, click Login. The ISD License Manager connects to the ISD License Server and the acquired
licenses will be displayed.

This process may take several minutes. You can then activate the licenses.
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Activate Licenses
After successful Login the number of available licenses and the number of acquired licenses are indicated next to
eachmodule.

Select the modules to be activated and click Activate to start the activation. For Server Licenses the modules are
already pre-selected.

After successful activation a message showing you that all licenses have been successfully activated will be dis-
played:

You can then log out and work with the HiCAD/HELiOSmodules.

In addition, you will receive an E-mail informing you about the deactivatedmodules.

For Network Licenses, all modules will always be activated or deactivated (for further information about the oper-
ation of the License Manager, please read the Online Help for the License Manager).
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Deactivate Licenses
A deactivation of licenses for modules will be required in the following situations:

n Exchange of hardware or changing of hard disk partitioning

n Update of the operating system (e.g. fromWindows 7 to Windows 10

n For updates within one version no deactivation will be required

n Transfer of local modules from one workstation to another

n Acquisition of further modules, or return of hired licenses

n Switch from local licenses to network licenses

Please note the following: All workstations with modules having the same Entitlement ID need to be deactivated
completely before a redistribution of the module licenses can take place.

Close all HiCAD/HELiOS applications before deactivating local licenses or logging onto the License Manager.

After starting the ISD License Manager the activatedmodules will be highlighted in a different colour.

Click the Deactivate button to revoke the activation of the modules.

A selection is not possible, as you need to deactivate all modules, no matter whether local licenses or network
licenses. The deactivation process must not be disrupted, e.g. by a logout or the closing of ISD License Manager!

After successful deactivation the following message will be displayed.
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Trial Licenses
If you select Display trial licenses after login, you will be also shown, besides all trial licenses with a limited period
of validity, all purchasable licenses which are not simultaneously available as trial licenses.

Reconstruction of Licenses
As all licenses are stored on the ISD Server, you can, in case of an interrupted connection or an accidental deletion
of licenses, restore all licenses by logging in with your Entitlement ID. The restoring will only function if the hardware
was not changed (see Deactivate Licenses).

Notes on the Use of Mobile Computers (Laptops)
If you use a computer with WLAN card, Please make sure that the WLAN card is either always switched on, or
always switched off.
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Floating Licenses
If you have acquired a HiCAD Extension Module with the property Floating- able at runtime , you can activ-

ate/deactivate them during the current HiCAD session. To do this, click on the m HiCAD nach dem Help icon
on the top right of the HiCAD screen and choose the option Floating Licenses. The HiCAD module selection win-
dow will be displayed:

If one Extension Module is (de)activated, the Extension Modules that are prerequisites for this module will also be
(de)activated (if they are also floating-able at runtime).
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Commuter Licenses
Commuter licenses enable you to use network licenses even if the workstation is not connected to the Server.
There are two ways of receiving commuter licenses:

n Checking Out Commuter Licenses, with Network Connection

n Checking Out Commuter Licenses, without Network Connection

Checking Out Commuter Licenses, with Network Connection
Start the ISD License Manager (while a connection to the Server still exists). Switch to the Commuter License tab.

If you have set the system environment variable LSFORCEHOST, the entered License Server will be displayed as the
preselected server upon start. Use the Search network button to automatically search for License Servers.

Expand the tree structure of the found Server by a click on the “+”-sign. The result looks as follows:

Installation Notes 159 / 190

HiCAD and HELiOS



Select the required licenses by activating the corresponding checkboxes on the left hand side.
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On the right hand side, information on the selected license is displayed.

In the Commuter license: Validity in days field, you enter the number of days that you want the commuter licenses
to remain checked out from the Server. The maximum number of days is 60. By default (or if a “0” is entered), the
value is set to 1.

For reasons of safety you should check out the licenses only for the required period! If a commuter license is lost,
e.g. because of theft or a defect of the client computer, the license on the Server cannot be used any more before
expiry of this date.

After entering the expiry date for the commuter licenses, click the Update licenses button. The Commuter licenses
are checked out from the Server.

All selected licenses are now checked out from the Server and you possess all rights on your computer for the spe-
cified validity period for the commuter licenses. This means that you are enabled to work network-independent. The
checked out licenses are no longer available to the other computers on the network.
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You can however also return the commuter licenses before their expiry date. To do this, you need to connect to the
Server, deactivate the checkboxes on the left and click the Update licenses button. All licenses are now made
available on the Server and locked on your computer, i.e. you can now only use HiCAD/HELiOS if there is a con-
nection to the License Server. The licenses made available again can now also be used from other workstations.

Checking Out Commuter Licenses, without Network Connection
Commuter licenses can also be drawn from the License Server without an existing network connection. For this
Administrator rights are required.

Commuter licenses checked out in this way cannot be returned to the License Server! This means that the com-
muter licenses that have been checked out from the Server are only (automatically) made available again after their
expiry date.

Several steps are required for checking out without network connection - by the Administrator having a network con-
nection to the License Server, as well as by the Client (that is, your laptop) having no network connection to the
License Server.

As long as commuter licenses are checked out in this way, it is not possible to update the network licenses on the
server. The same applies when buying new modules/licenses and changing the configuration.

The Client starts the ISD License Manager tool, switches to the Remote Locking Code tab.
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Then, the Client sends the generated character set to the Administrator (via E-mail or over the phone).

The Administrator starts the ISD License Manager and switches to the Commuter License tab.
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The License Server will be selected, and the required licenses (modules) are activated in the left window. In the
Commuter license: Validity in days field, you enter the number of days that you want the commuter licenses to
remain checked out from the Server. The maximum number of days is 60. By default (or if a “0” is entered), the
value is set to 1. To checkout a remote commuter license the administrator now needs to activate the Check out
authorisation for remote computer checkbox . Administrator rights are required for this.

A click on the Update licenses button opens a new dialogue window, in which the administrator enters the char-
acter set received from the Client

After selecting OK, another dialogue opens.

Here the Administrator enters the target path and the file name for the licenses to be swapped out. Make sure that
a unique file name is used, for example, by including in the file name the host name of the remote computer and
the expiry date.

Click OK to check out the commuter licenses from the License Server and swap them out to a file, e.g.
RemoteLicCode.lic.

After receiving the file with the commuter licenses, the Client starts the ISD License Manager again and activates
the Install Remote Authorisation Code tab.
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Now the Client can install the received commuter licenses directly via file selection or via copying of the file con-
tents. Click the Install Remote Commuter License button to install the Commuter Licenses on the Client.

After successful installation, the Client must switch to the Standalone License Info tab.

Installation Notes 165 / 190

HiCAD and HELiOS



To update, the Client must click on the Activate button. The information which licenses are installed locally on the
computer will then be provided to the Client.
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License Configuration
Some cases may require the use of only certain specific licences on a computer. Example: On the License Server
HiCAD Creator and HiCAD Solution licenses are available. On one Client, HiCAD is to be started with a HiCAD
Creator license; on another Client, with a HiCAD Solution license. If the selected license is no longer available, an
application start is no longer possible.

If there are several basic modules in a standalone (workstation) license (to which also the Commuter Licenses
belong), it is mandatory to make a pre-configuration and save it as workstation configuration. If no pre-con-
figuration is possible, the HiCAD configuration tab will be displayed before the start of HiCAD/HELiOS. If the selec-
ted configuration does not match the available licenses, a warning message will be issued, with a list of available
licenses. After this, the configuration selection will be displayed again.
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On the HiCAD Configuration or HELiOS Configuration of the ISD License Manager tool you have the option to
save a workstation or user configuration for individual Clients.

n Save as workstation configuration: This configuration will be saved for all users of this computer. When
HiCAD/HELiOS is started, the selection window is no longer displayed (administrator rights are required for this).

n Save as user configuration: This configuration is only saved for the current user. When HiCAD/HELiOS is star-
ted, the selection window with the saved configuration is always displayed.

These license configurations apply to network licenses and standalone (workstation) licenses.
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Server Monitor
With the ISD License Manager tab Server Monitor you are allowed (as far as you are able to execute ISD License
Manager) to view detailed information as follows:

n Listing of available modules with module description (e.g. “Element Installation”). Relevant is the License
Server which the user is connected with.

n Apart from the module description, the maximum amount of available licenses as well as allocated licenses is
displayed.

n You can open up the available modules and here the users using the respective license are displayed.

n The listing of users using a license also shows which user is connected with the License Server and which user
uses a Commuter License.

By listing the licenses you can easily see who blocks licenses and, for example, easily speak to them in case if you
need a license.

In the installation program, the tab Server Monitor is activated by clicking on the option Activate license admin-
istration tools.

Installation Notes 169 / 190

HiCAD and HELiOS



Theft of a Workstation
The user is responsible for appropriately insuring the HiCAD and HELiOS workstations against theft. If desired, we
can tell you the reinstatement value of your software. If a workstation is stolen, you will need a new license. In such
cases, please send us the police report of the theft first. We will then provide you with a license for a limited period
of time, and submit an offer for a new license to you. The ISD will send you the new license after clarification of the
case with your insurance and receipt of your payment for the license fee.
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First Steps
n HiCAD at a Glance

n Start HiCAD

n DLL Check

n Start Center

n Close HiCAD

n HELiOS at a Glance

n Start HELiOS

n What's New in Version 2020?
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HiCAD at a Glance
HiCAD is a versatile CAD with a unique, combined 2-D/3-D approach, innovative functions, comprehensive industry
solutions and an integrated PDM component. State-of-the-art technologies and a multitude of automatisms help
you speed up your daily routine tasks. And simulation and analysis tools enable you to find and correct possible col-
lisions and errors in your product models at very early design stages.

Performance characteristics:

n Microsoft Windows Standard

n GUI with multifunctional toolbar (Ribbon)

n Combined, fully associative working in 2-D and 3-D

n From 2-D to 3-D via model reconstruction

n Part-oriented designing

n Combined free ("direct") and parametric modelling

n Information + Communication Navigator (ICN)

n Automatic object snap and context menus (opened via right-click)

n Access to extensive symbol and standard part libraries (also online)

n Function simulation with the HiCAD Constraints Manager (HCM)

n Mounting, transport andmotion simulations

n Free-form surface (FFS) technology

n Part referencing

n Feature technology

n Material Editor and lighting models

n Integrated Product Data Management (PDM) with HELiOS

n Transfer of data from other systems (CATIA, ME10, STEP, DXF, DWG etc.)

n BOM creation, PPS interface, data transfer to NC machines

n Powerful and versatile industry solutions

n Modular, expandable structure
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Start HiCAD
You start HiCAD by

n Selecting the HiCAD symbol via the Start button on the Windows task bar (Start > All Programs >ISD Soft-
ware und Systeme > HiCAD), or

n via the HiCAD icon on the Desktop of your computer.

Once you have started HiCAD, the input window for License Management is initially displayed, followed by the
HiCAD Start Centre (provided that it has not been deactivated).

If you use HiCAD in conjunction with HELiOS, a login may be required to start HiCAD.

To make the best possible use of the numerous new features and enhancements offered by HiCAD, check out the
videos explaining the new and changed HELiOS functionalities. From now on we will provide you with such videos
with eachMajor Release and Service Pack to keep you constantly informed in the best possible way.

You can configure the display of the News window at the bottom left. Please note that you can configure the dis-
play of the News window at the bottom left. We recommend using the Show most recent news option to ensure
that you will never miss any news about HiCAD. If you selected the Show never option, you can call the News win-

dow again at any time and change the display option by clicking on the symbol at the top right and selecting
Show news.

Please note:

During the start of HiCAD it is checked whether the required version of .NET Framework is actually installed. If
this is not the case, an appropriate error message will be displayed and HiCAD will be closed.
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DLL Check
Due to entries in the Windows-Registry, more and more libraries from third parties (DLL file) are integrated when
HiCAD is launched, e.g. in order to capture messages or outputs to the screen. Some examples are

n Virus scanners,

n PDF creation programs,

n Programs for recording of screen activities,

etc. These files can sometimes cause problems.

When you start HiCAD, it will first be checked whether DLL files are assigned to the Registry value AppInit in the
Registry key

n HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Windows (64-Bit)

n HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows NT\CurrentVersion\Windows (32-Bit)

If this is the case, the following message will be displayed:

Activate the Suppress message checkbox if you do not want this message to be displayed upon future HiCAD
starts. Also inform your administrator about the message. The message will not reappear until the Registry value
changes again, i.e. not until other DLLs will be loaded!

If you want to completely suppress the message, you can also set the registry value CheckBoxState in the registry
key

n HKEY_CURRENT_USER\Software\ISD Software und Systeme\HiCAD [Jahresversion, z.B. 2020]\Splash Screen

to 1.

Important:

Be careful when editing the Registry! The entering of incorrect values or the deleting of values may destablilize
the operating system!
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Start Centre
When you start HiCAD for the first time, the Start Centre will be displayed, which has been designed to facilitate
your first steps of drawing creation.

n Click on the graphic to obtain information about the version number, the name of the current drawing and the

occupiedmemory. This corresponds to the calling of the function HiCAD in the menu.

n When you call the Start Centre again, the last set values will be displayed as default values.

n The settings you have selected for the start action Create new drawing will even be used in HiCAD if you call
the New drawing function while the Start Centre is inactive.

If you want to create a new drawing, specify whether you want to create a part drawing or an assembly drawing by
activating the appropriate checkbox.

n Part drawing (aka Detail drawing)
In a part drawing (detail drawing) you divide your drawing into main parts and sub-parts. To define the part struc-
ture you use so-called dummy parts which symbolise the assembly. You then assign assembly-relevant main
parts and sub-parts to these dummy parts. Instead of dummy parts youmay as well use the special part type
Assembly.

n Assembly drawing
You can define 3-D drawings directly when creating the assembly drawing and - if you are working in parallel
with HELiOS - enter them into the database. This provides significantly more efficiency, particularly for ref-
erencing, itemisation and BOM-creation.
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Options
n Enter drawing into database

You can define 3-D drawings directly when creating the assembly drawing and - if you are working in parallel
with HELiOS - enter them into the database. This provides significantly more efficiency, particularly for ref-
erencing, itemisation and BOM-creation. If you are working with HELiOS you can define here whether you want
to the new drawing to be entered into the database. If you activate this checkbox, HiCAD will prompt you to spe-
cify the document master data once you exit the Start Centre. If not, you will be prompted to enter the name of
the drawing file.
Activate, if desired, the project to which you want to assign the drawing.

n Scale
Here you can preset the scale of the drawing.

n Start mode
Here, choose the start mode you want to be activated once you exit the Start Centre, e.g. 2-D, if you want to
start the drawing in 2-D or 3-D Extruded solid, if you want to start your drawing by creating an extruded solid in
3-D.

n Create processing planes (3-D only)
Here you can specify which of the standard processing planes you want to create. Activate the appropriate
checkbox.

n View projection and View representation (3-D only)
If you want to work in 3-D, use these functions to pre-set the model view and the view representation.

Load existing drawing
If you have chosen Load existing drawing as start mode, you can specify whether you want to load the drawing via
the database, the Explorer or via an interface. As with a new creation, youmay also activate the project directly.

Switch Start Centre off
If you activate the Switch Start Centre display off checkbox and click OK to exit the Start centre, the current set-
tings will apply as the default settings for whenever you start HICAD again and create new drawings. The Start
Centre is then no longer displayed. To re-activate the Start Centre display and to change the settings, choose Set-
tings > Activate Start Centre. The changed settings will be applied when starting HiCAD again.

If you click OK to exit the Start Centre, the current settings are used as the default setting if, on the other hand, you
exit the Start Centre by pressing the ESC key or clicking on the icon, the settings will be ignored.
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Close HiCAD
To close HiCAD,

n just click on the icon at the top right , or

n Click on the ISD Button at the top left and choose End.

If HiCAD drawings are still open at this point, you have the option to save them. HiCAD distinguishes between the
currently open drawing, i.e. the one that you see on your screen, and other drawings that are also still open. If a file
with the same name already exists, you can either save the drawing under a different name, or overwrite the exist-
ing file with the same name. Please note however that no backup copy will be created in this case!

Important:

When closing HiCAD, all files except for the auto-saved files will be removed from the TEMP directory of your
HiCAD installation.
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HELiOS at a Glance
On the way to the finished product, invested time, spent costs and product quality can only be optimised if all
departments of a company cooperate efficiently. This requires a well-structured and efficient exchange of inform-
ation between the parties involved in the production process - from Manufacturing, Purchasing and Service to Mar-
keting and Sales.

HELiOS is a state-of-the-art PDM/PLM system providing all essential tools for an error-free gathering, management
and distribution of the data required for the production process chain. Once saved, these data can be re-used within
the entire company and for the complete product life cycle. HELiOSmanages and controls all process cycles by reg-
ulating andmonitoring the processing and transfer of these data.

By combining Product, Process and Peripherals Management in a single system, HELiOS becomes the central
“knowledge reservoir” of your company and guarantees transparent and secure processes.

HELiOS can be interfaced with your CAD system or used as a stand-alone system, the so-called HELiOS Desktop -
either as a single workstation or at different locations.

Thanks to its modular structure, HELiOS can be optimally adapted to company-specific requirements.
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Start HELiOS
Start the HELiOS Desktop by double-clicking on the HELiOS.EXE file in the \HELiOS\exe directory or via the HELiOS

icon on the Desktop of your computer.

Default setting is the project-independent start. Please note that the list view in the right-hand window will not be
shown when you start HELiOS Desktop for the first time. Select a project first and display the list view via View and
then Lists.

If you have not closed HELiOS correctly during your last session, you will receive an error message from the Vault
Server.

To make the best possible use of the numerous new features and enhancements offered by HELiOS, check out the
videos explaining the new and changed HELiOS functionalities. From now on we will provide you with such videos
with eachMajor Release and Service Pack to keep you constantly informed in the best possible way.

You can configure the display of the News window at the bottom left. Please note that you can configure the dis-
play of the News window at the bottom left. We recommend using the Show most recent news option to ensure
that you will never miss any news about HELiOS. If you selected the Show never option, you can call the News win-

dow again at any time and change the display option by clicking on the symbol at the top right and selecting
Show news.

Login
The HELiOS User Management is based on the User Management of Windows. If several users are registered with
the same Windows User Name in EDBSETUP, a login mask will appear when starting HELiOS Desktop.

Name and active group enable the user to login with the rights guaranteed by the User Management.
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If you select a project from the Active project drop-down list, this project will be opened after starting HELiOS
Desktop. If you select the project-independent setting, all documents will be displayed.

Start the HELiOS Desktop with Login.

To ensure that a specific project will be opened after starting HELiOS Desktop, you need to specify a Start Project.
On the Ribbon, activate the Tools tab, then select Options, activate in the dialogue the General tab and choose a
start project.

Switch user

Use the Switch user function for a renewed login while working with HELiOS Desktop, e.g. to work with dif-
ferent rights without having to exit the program.

Activate the Switch user function via the QuickAccess toolbar. Select a different user. Change the active pro-
ject if required and confirm the new settings with Login.
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What's New in Version 2020?
An extensive overview of all changes and enhancements of HiCAD 2020 can be found in the What's new? topic of

the Help. You can also click on the button in the Help.

An overview in PDF format will be displayed if you click on the button in the Download area of the ISD
Wiki.
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How to Use the Help
The Online Help provides you with information, descriptions and examples on all functions and techniques which
are available in HiCAD/HELiOS.

Please note:

The scope of available functions may vary, depending on the configuration of your HiCAD/HELiOS product.
This means that some of the functions described in the Online Helpmay not be available in your version.

The Help is available both locally (status of the installation DVD) and on the Internet (regularly updated) at help.is-
dgroup.com. Both versions of the Help can be called from HiCAD/HELiOS.

You can call the Help in HiCAD via the Help Topics and Information menu.

Choose > Help Settings to determine which version of the Help will be used.

Click on the button to call the HELiOS Help.

Choose > HELiOS Options to determine which version of the Help will be used.
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Please note:

If youmove the cursor over a function on the Ribbon and press the F1 key, the Help page for that specific func-
tion will be displayed.

To be able to use the Internet version of the Help, you need to register for the ISD’s new company Wiki once. This
will not only give you access to the new Help, but also provide you with many other information which will be made
available shortly in the ISD Wiki (Forum, Download area etc.)

Click Sign up in the login window of the Online Help to register. If you have already been registered, enter your
access data and click Login to get directly to the start page of the Online Help.

After clicking Sign up in the Login window of the Online Help, enter the data required for the ISD Wiki in the dia-
logue window. Confirm the security prompt and click the Sign up button.
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After successful registration the dashboard of the ISD Wiki will be displayed. A message indicates whether you have
been authenticated as an ISD customer.

If you could be identified as an ISD customer, you can now directly launch the Online Help using your registration
data.

If you could not be identified as an ISD customer, please perform the steps described in the message.

Important:

By default the Online Help has been selected after installation. If you prefer using the local Help, start the
InstallationWizard again and click on the HiCAD and HELiOS Help button.
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Hotline
Even after implementation, the support team of the ISD ensures competent support of their customers. Besides sup-
port over the phone, all current means of communication such as Fax, E-mail and Internet can be used. If any prob-
lems could not be solved in this way, our staff in all our offices will be there to help you at your company if required.

Germany Netherlands Austria Switzerland

Phone +49 (0)231 9793-166 +31 (0)73 6153-888 +43 (0)732 21 04 22-
28

+41 (0)32 624 13-47

E-Mail support@isdgroup.com

Service
hours

FromMonday to
Thursday:
between 8:00 am
and 5:00 pm

On Friday:
between 8:00 am
and 3:00 pm

FromMonday to Fri-
day:
between 8:00 am
and 5:00 pm

FromMonday to
Thursday:
between 8:00 am
and 5:00 pm

On Friday:
between 8:00 am
and 3:00 pm

FromMonday to
Thursday:
between 8:00 am
and 5:00 pm

On Friday:
between 8:00 am
and 3:00 pm

If all lines are busy, a voice mail system will be activated, allowing you to leave a message. Our staff will call you
back as soon as possible. If a line becomes available during the recording of your message, your call will be accep-
ted immediately. It is our ambition to solve your problems as quickly as possible and let you have the solution via
phone or E-mail. A problem diagnosis will be made on the spot, and the existing problem will be dealt with and elim-
inated as fast as possible.

In cases where your problem cannot be solved immediately, we will call you back after analyzing the situation.
Depending on the level of difficulty our Hotline will also bring in the Development department.
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Copyright
© 2011-2020 ISD ® Software und Systeme GmbH. All rights reserved.

This User Guide and the software described herein are provided in conjunction with a license and may only be used
or copied in accordance with the terms of the license. The contents of this User Guide solely serve the purpose of
information; it may be modified without prior notice and may not be regarded as binding for the ISD Software und
Systeme GmbH. The ISD Software und Systeme GmbH does not assume any responsibility for the correctness or
accuracy of the information provided in this document. No part of this document may be reproduced, saved to data-
bases or transferred in any other form without prior written permission by the ISD Software und Systeme GmbH,
unless expressly allowed by virtue of the license agreement.

All mentioned products are trademarks or registered trademarks of their respective manufacturers and producers.

Sentinel® RMS and EMS

The license management portion of this Licensee Application is based upon one or more of the following copy-
rights:

n Sentinel®RMS, © 2009-2020 Thales Group. All rights reserved.

n Sentinel®EMS, © 2009-2020 Thales Group. All rights reserved.

Sentinel® is a registered trademark of the Thales Group.

PDF3D®

PDF3D®, © 2003-2020 Visual Technology Services Ltd. All rights reserved.

PDF3D® is a registered trademark of Visual Technology Services Ltd.

Scene API Standardalone Developer Package®

The HiCAD Point Cloudmodule contains the SCENE API Standalone Developer Package®.

This is an original product of FARO® Technologies Inc. and protected by copyright.

Protocol Buffer

Copyright 2008, Google Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the fol-
lowing conditions are met:

n Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

n Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the fol-
lowing disclaimer in the documentation and/or other materials provided with the distribution.

n Neither the name of Google Inc. nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS"AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
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HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANYWAY OUT OF THEUSE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Code generated by the Protocol Buffer compiler is owned by the owner of the input file used when generating it.
This code is not standalone and requires a support library to be linked with it. This support library is itself covered by
the above license.

D-Cubed

This work contains the following software owned by Siemens Industry Software Limited:

D-Cubed® 2D DCM© 2020. Siemens Industry Software Limited. All rights reserved.

D-Cubed® 3D DCM© 2020. Siemens Industry Software Limited. All rights reserved.

D-Cubed® AEM© 2020. Siemens Industry Software Limited. All rights reserved.

lp_solve

HiCAD uses the lp_solve library. lp_solve is an Open Source project provided under the GNU General Public
License (LGPL) as published by the Free Software Foundation.

See http://lpsolve.sourceforge.net/5.5/LGPL.htm for details.

EPPLUS

HiCAD uses the EPPLUS library. EPPlus is an Open Source project provided under the GNU General Public License
(LGPL) as published by the Free Software Foundation.

See http://epplus.codeplex.com/license for details.

FreeImage

HiCAD uses the FreeImage open source image library. FreeImage is licensed under the FreeImage Public License
(FIPL).

See http://freeimage.sourceforge.net for details.

FreeType

Portions of this software are copyright 2018 The FreeType Project (www.freetype.org). All rights reserved.

Autofac, Copyright © 2020 Autofac Project

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated doc-
umentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons
to whom the Software is furnished to do so, subject to the following conditions: The above copyright notice and this
permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUTNOT LIMITED TO THEWARRANTIES OFMERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.
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Castle.Core, Copyright © 2004-2020 Castle Project

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance
with the License. You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0 Unless
required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS"
BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the License for
the specific language governing permissions and limitations under the License.

Apache log4net, Copyright © 2004-2020 The Apache Software Foundation

This product includes software developed at The Apache Software Foundation (http://www.apache.org/). Licensed
under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the
License. You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0 Unless required by
applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS" BASIS,
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the License for the spe-
cific language governing permissions and limitations under the License.

NHibernate, Copyright © The NHibernate Project

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser General
Public License as published by the Free Software Foundation (version 2.1). This library is distributed in the hope that
it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or
FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for more details. You should
have received a copy of the GNU Lesser General Public License along with this library; if not, write to the Free Soft-
ware Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA.

Fluent NHibernate, Copyright © 2008-2020, James Gregory and contributors

All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

n Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

n Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the fol-
lowing disclaimer in the documentation and/or other materials provided with the distribution.

n Neither the name of James Gregory nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANYWAY OUT OF THEUSE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Legal notes

© 2020 ISD® Software und SystemeGmbH. All rights reserved.

This User Guide and the software described herein are provided in conjunction with a license and may only be used or copied in accordancewith the
terms of the license. The contents of this User Guide solely serve the purpose of information; it may bemodified without prior notice and may not be
regarded as binding for the ISD Software und SystemeGmbH. The ISD Software und SystemeGmbH does not assumeany responsibility for the cor-
rectness or accuracy of the information provided in this document. No part of this document may be reproduced, saved to databases or transferred
in any other form without prior written permission by the ISD Software und Systeme GmbH, unless expressly allowed by virtue of the license agree-
ment.

Allmentioned products are trademarks or registered trademarks of their respectivemanufacturers and producers.
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